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r a Class B digital device, pursuant
sonable protection against harmful
es and can radiate radio frequency
s, may cause harmful interference
ence will not occur in a particular
 or television reception, which can
ed to try to correct the interference

ich the receiver is connected.
for help.

autioned that changes or modifica-
ove standards could void your au-
FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits fo
to Part 15 of the FCC Rules. These limits are designed to provide rea
interference in a residential installation. This equipment generates, us
energy and, if not installed and used in accordance with the instruction
to radio communications. However, there is no guarantee that interfer
installation. If this equipment does cause harmful interference to radio
be determined by turning the equipment off and on, the user is encourag
by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to wh
• Consult the service representative or an experienced radio/TV technician 

Warning
Use only shielded cables to connect I/O devices to this equipment. You are c
tions not expressly approved by the manufacturer for compliance with the ab
thority to operate the equipment.
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TIONS
 the risk of fire, electric shock, and

h bowl, kitchen sink or laundry tub, 

ss type) during an electrical storm. 

k.
t dispose of batteries in a fire. They 

structions.
utput 20V, 3.25A minimum).

icing or disassembling this equip-

. 26 AWG OR LARGER, 
ORD

aser Product
IMPORTANT SAFETY INSTRUC
Follow basic safety precautions, including those listed below, to reduce
injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, was
in a wet basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordle
There may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the lea
4. Use only the power cord and batteries indicated in this manual. Do no

may explode. Check with local codes for possible special disposal in
5. This product is intended to be supplied by a Listed Power Unit (DC O

CAUTION
Always disconnect all telephone lines from the wall outlet before serv
ment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO
TELECOMMUNICATION LINE C

This Computer’s Optical Device is a Class I L
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vent this, follow these suggestions:

 and the components could be dam-

pply away from any kind of heating 
ts into it, the computer could be 

ot place anything heavy 
e computer.

 com-
ironment.

Do not place the computer on 
any surface that will block the 
vents.
Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To pre

1. Don’t drop it, or expose it to shock. If the computer falls, the case
aged.

2. Keep it dry, and don’t overheat it. Keep the computer and power su
element. This is an electrical appliance. If water or any other liquid ge
badly damaged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do n
on th

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the
puter in a humid env
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sformers, electric motors, and other 
mage your data.

 computer down properly and don’t 
s data may be lost if the battery is 

he com- Perform routine maintenance 
on your computer.

rd before 
 devices.
3. Avoid interference. Keep the computer away from high capacity tran
strong magnetic fields. These can hinder proper performance and da

4. Follow the proper working procedures for the computer. Shut the
forget to save your work. Remember to periodically save your data a
depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble t
puter by yourself.

Use only approved brands of 
peripherals.

Unplug the power co
attaching peripheral
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ith this computer.
tional travel but it still requires a 

e unsure of your local power specifi-
r local power company.
 or a 3-prong grounded plug. The 

 not defeat its purpose. If you do not 
alified electrician install one.
sure to disconnect it by the plug head, 

(s) you use can support the total cur-

 disconnected from any external 
r).

r cord if Do not place heavy objects 
on the power cord.
I

Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use w
• Your AC adapter may be designed for interna

steady, uninterrupted power supply. If you ar
cations, consult your service representative o

• The power adapter may have either a 2-prong
third prong is an important safety feature; do
have access to a compatible outlet, have a qu

• When you want to unplug the power cord, be 
not by its wire.

• Make sure the socket and any extension cord
rent load of all the connected devices.

• Before cleaning the computer, make sure it is
power supplies (i.e. AC adapter or car adapte

Do not plug in the power 
cord if you are wet.

Do not use the powe
it is broken.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
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y explode, leak or damage the com-

maged (e.g. bent or twisted) in any 
lace, it may cause circuit damage, 

may make the battery explode.
ement to your service representative 

ways dispose of batteries carefully. 
 discarded.

attery is recyclable. At the end of its
his battery into the municipal waste
ecycling options or proper disposal.

e or equivalent type recommended
structions.
Battery Precautions
• Only use batteries designed for this computer. The wrong battery type ma

puter.
• Do not continue to use a battery that has been dropped, or that appears da

way. Even if the computer continues to work with a damaged battery in p
which may possibly result in fire.

• Recharge the batteries using the notebook’s system. Incorrect recharging 
• Do not try to repair a battery pack. Refer any battery pack repair or replac

or qualified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Al

Batteries may explode or leak if exposed to fire, or improperly handled or
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The b
useful life, under various state and local laws, it may be illegal to dispose of t
stream. Check with your local solid waste officials for details in your area for r

Danger of explosion if battery is incorrectly replaced. Replace only with the sam
by the manufacturer. Discard used battery according to the manufacturer’s in
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part of the computer.

 your warranty and expose you and
e personnel. Unplug the computer
nel under any of the following con-

structions.
s liquid if the LCD panel breaks).
III

Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any 

Servicing
Do not attempt to service the computer yourself. Doing so may violate
the computer to electric shock. Refer all servicing to authorized servic
from the power supply. Then refer servicing to qualified service person
ditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating in
• If the computer has been dropped or damaged (do not touch the poisonou
• If there is an unusual odor, heat or smoke coming from your computer.
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stem is ready to go:

g. 
ed a second voltage adapter. How-
ters.
s.
a), pack them and those devices’ 

 or require proof of ownership for 

 travel bag (or any such container).
/intakes to be blocked. To prevent
e while the computer is in use.
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the sy

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC adapter and cables. Stow them in the carrying ba
5. The AC adapter uses voltages from 100 to 240 volts so you won’t ne

ever, check with your travel agent to see if you need any socket adap
6. Put the notebook in its carrying bag and secure it with the bag’s strap
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camer

adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions

both hardware and software.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a
Putting a notebook which is powered on in a travel bag may cause the vents
your computer from overheating make sure nothing blocks the vent/fan intak



X

Preface

face, and Chapter 8: Troubleshoot-

t. In some areas, computer theft is
rs may not be sufficiently careful.

& X-ray machines can damage the
estroy any stored data - Pass your
inspect them (you may be asked to

rs and other electronic devices in
 the notebook in an overhead com-
n the compartment is opened.

he AC adapter and keep your bat-

ater vapor can condense inside the
e can evaporate.
On the Road
In addition to the general safety and maintenance suggestions in this pre
ing, keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sigh
very common. Don’t check it with “normal” luggage. Baggage handle
Avoid knocking the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors 
computer, hard disk, floppy disks, and other media. They may also d
computer and disks around the devices. Ask security officials to hand-
turn it on). Note: Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of compute
flight. These restrictions are for your safety, follow them. If you stow
partment, make sure it’s secure. Contents may shift and/or fall out whe

Get power where you can - If an electrical outlet is available, use t
tery(ies) charged.

Keep it dry - If you move quickly from a cold to a warm location, w
computer. Wait a few minutes before turning it on so that any moistur
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t of the computer for long periods
jury from repetitive strain to your
 strain:

htly 
 relaxed 

n the 

bly.
gree 

e.

time. Fre-
Developing Good Work Habits
Developing good work habits is important if you need to work in fron
of time. Improper work habits can result in discomfort or serious in
hands, wrists or other joints. The following are some tips to reduce the

• Adjust the height of the chair and/or desk so that the keyboard is at or slig
below the level of your elbow. Keep your forearms, wrists, and hands in a
position.

• Your knees should be slightly higher than your hips. Place your feet flat o
floor or on a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comforta
• Sit straight so that your knees, hips and elbows form approximately 90-de

angles when you are working.
• Take periodic breaks if you are using the computer for long periods of tim

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of 

quent and short breaks are better than fewer and longer breaks.
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 strain and muscle fatigue in your

r outside sources of light.
 that allow you to see the screen 

nce.
II

Lighting
Proper lighting and comfortable display viewing angle can reduce eye
neck and shoulders.

• Position the display to avoid glare or reflections from overhead lighting o
• Keep the display screen clean and set the brightness and contrast to levels

clearly.
• Position the display directly in front of you at a comfortable viewing dista
• Adjust the display-viewing angle to find the best position.
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1Introduction

n your
e or all

wever
S Util-
u may

f them)
 if you
d refer
d with

Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features.
Chapter 1: Introduction
Overview
This manual refers to the hardware and essential software required to ru
notebook computer. Depending on how your system is configured, som
of the features described may already be set up. This chapter covers:

• The Manual — how to use it
• System Map — navigating around your computer

Advanced Users
If you are an advanced user you may skip over most of this manual. Ho
you may find it useful to refer to “What to Install” on page 4 - 1, “BIO
ities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1. Yo
also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge o
then you should try to look through all the documentation. Do not worry
do not understand everything the first time. Keep this manual nearby an
to it to learn as you go. You may find it useful to refer to the notes marke
a  as indicated in the margin.
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1

l attention to the warning and safe-
l. Also please note the safety and
eface.

ofessional, Windows XP etc.) have
. word processing, spreadsheet and
about the operating systems or pro-
manuals.

stem software pre-installed. Where
nfiguring your computer for a dif-
fers to the following operating sys-

ssional Editions)
- 2 Overview

Warning Boxes
No matter what your level please pay carefu
ty information indicated by the  symbo
handling instructions as indicated in the Pr

Not Included
Operating Systems (e.g. Windows 2000 Pr
their own manuals, as do applications (e.g
database programs). If you have questions 
grams then please consult the appropriate 

System Software
Your computer may already come with sy
this is not the case, or where you are re-co
ferent system, you will find this manual re
tems:

• Microsoft Windows 2000
• Microsoft Windows XP (Home & Profe
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an tell
t com-

 pages,

is any-
 before

e ready
nstruc-

.g. 

(see 
o an 

Peripheral Devices

Please note that pe-
ripherals (printers, dig-
ital cameras, etc.)
which attach to your
computer by USB
ports may be connect-
ed after Windows is
up and running. All oth-
er peripherals must be
connected before you
turn on the system.
Quick Start Guide
This guide assumes that you are already familiar with computers and c
at a glance what and where all the key components are. If you are not tha
fortable with this type of device, then please refer to the following
which give an overview of the system.

It is still best to review these steps, before taking any action. If there 
thing you are not sure about, then please refer to the appropriate chapter
continuing.

Unless you need to install an operating system, your computer should b
to work right out of the box. Before you begin please follow the safety i
tions in the Preface.

1. Remove all packing materials.
2. Securely attach any peripherals you want to use with the notebook (e

keyboard and mouse) to their ports.
3. Attach the AC adapter to the DC-In jack on the right of the computer 

“Right Side View” on page 1 - 16), then plug the AC power cord int
outlet, and connect the AC power cord to the AC adapter.

4. Raise the lid/LCD to a comfortable viewing angle.
5. Press the power button to turn “on”.
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1

1

. Most of these are enabled by your
he various subsystems are covered

er
come familiar with the basic func-
orts and components of your com-

t model types. Model A has a stan-
e “LCD” on page A - 3 for details).
s (note the touchpad and buttons -
5.
- 4 System Map

System Map
Your computer has a lot of built-in features
operating system. Further explanations of t
in the chapter or pages indicated.

Getting to Know Your Comput
The following graphics will help you to be
tions, and learn the location of the various p
puter.

Model Differences
This notebook series includes two differen
dard screen, Model B has a wide screen (se
Both models include two different design
see Figure 1 - 1) as illustrated on page 1 - 
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Figure 1 - 1
Model & 

Design Differences

Design Differences

There are also col-
ored gloss style top
cover designs for
both model types. See
Figure 1 - 2 for an illus-
tration. Note the spe-
cific care instructions
for this type of cover.
Model AModel A
Design I Design II

Model B 

Design I
(Wide Screen)
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1

ave colored gloss style top covers.
 attention of this type of top cover.

 carefully. Do not forcibly tear off 
e the surface of the top cover.
ce of the top cover, and do not 

e heat or direct sunlight.
ning the top cover, and do not use 
- 6 System Map

Gloss Style Top Cover Designs
Some designs within this notebook series h
Note the following guidelines for care and

• Remove the protective cover slowly and
the protective cover as this may damag

• Do not use pointed objects on the surfa
place objects on top of it.

• Do not expose the top cover to excessiv
• Only use the soft cloth provided for clea

abrasive cleaners.

Figure 1 - 2
Gloss Style Top Cover
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Figure 1 - 3
Top View with LCD 

Panel Closed

1. LCD Latches
2. LED Power & 

Communication 
Indicators
Top View

To open the LCD display:
1. Place the computer on a stable surface.
2. Move the LCD latches  in the direction of the arrows to release the

cover (the left latch will lock in position and is clearly marked with loc
and unlocked  icons).

3. Lift the top cover to reveal the LCD panel and keyboard.
4. Adjust the LCD panel to a comfortable viewing angle.
5. The LED indicators  show the power and battery status of the com

and give notification of e-mail received.

2

1 1

1

2
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 - Model A

6

7

5

- 8 Top View

Top View with LCD Panel Open
Figure 1 - 4

Top View with LCD 
Panel Open - Model A

1. Optional Built-In PC 
Camera

2. LCD
3. LED Power & 

Communication 
Indicators

4. Speakers
5. Lid Sensor
6. LED Status 

Indicators
7. Power Button
8. Keyboard
9. Built-In Microphone
10. TouchPad and 

Buttons

2

34

1

9

10

4

8
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Figure 1 - 5
Top View with LCD 

Panel Open - Model B

1. Optional Built-In PC 
Camera

2. LCD
3. LED Power & 

Communication 
Indicators

4. Speakers
5. Lid Sensor
6. LED Status 

Indicators
7. Power Button
8. Keyboard
9. Built-In Microphone
10. TouchPad and 

Buttons
Top View with LCD Panel Open - Model B

2

6
34

1

9

7

10

4

8

5
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era, make sure you install the soft-
age 7 - 11). The Module ON/OFF
 (see “Module ON/OFF Button”

m Transistor), Liquid Crystal Dis-
th Model A and Model B comput-

icators
r status, and battery status of the
gured to give a visual confirmation
ail program (see “LED Power &
).

sound.
- 10 Top View

PC Camera
If you have purchased the optional PC Cam
ware application (see “PC Camera” on p
Button will enable/disable the PC Camera
on page 1 - 13).

LCD Panel
The computer comes with a TFT (Thin Fil
play screen (see page A - 3 for details on bo
ers).

LED Power & Communication Ind
These indicators display the system powe
computer. The third indicator may be confi
when e-mail is received in the default e-m
Communication Indicators” on page 2 - 6

Stereo Speakers
Two built-in speakers provide rich, stereo 
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 Com-
e key,
ur op- Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination
doesn’t work, press the
power button for 4 sec-
onds, or longer, to
force the system to
turn itself off.

hut
 will
Lid Sensor
When this LCD cover sensor is activated by closing the LCD panel, 
fault setting of your operating system’s power scheme sends the compu
a power saving state (see Figure 3 - 13 on page 3 - 19).

LED Status Indicators
These display the system’s operational status. Refer to “LED Status I
tors” on page 2 - 5 for more information on what the lights mean.

Power Button
Press this button to turn your computer on or off (see “Turning on the
puter” on page 2 - 4). This button may also be used as a suspend/resum
once configured as such in the power management control panel of yo
erating system (see “Configuring the Power Button” on page 3 - 19).

Shutdown

Please note that you should always shut your computer down by choosing the S
Down/Turn Off Computer command from the Start menu in Windows. This
help prevent hard disk or system problems.
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1

including a numeric keypad. It has
eyboard and can easily be replaced
 you desire.

e built-in microphone.

lide pad for precise movements. It
use. The right TouchPad button is

ft TouchPad button is the same as
ay be used to scroll up and down,

 of functions (see “TouchPad and
- 12 Top View

Keyboard
The computer has a “Win Key” keyboard 
the same features as a full-sized desktop k
with a different language keyboard should

Microphone
Record on your notebook computer with th

TouchPad & Buttons
The pointing device features a sensitive g
functions the same way as a two-button mo
the same as the right mouse button; the le
the left mouse button. The central button m
or may be configured to perform a variety
Buttons/Mouse” on page 2 - 18).
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age 2 -

/or PC
ON or
are for
etooth
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rd air-

Figure 1 - 6
Front View

1. LCD Latches
2. HK Buttons

Wireless Device 
Operation Aboard 

Aircraft

The use of any porta-
ble electronic trans-
mission devices
aboard aircraft is usu-
ally prohibited. Make
sure the module(s) are
OFF if you are using
the computer aboard
aircraft. When your
computer ‘Boots Up’
the modules will be
OFF. 
Front View

HK Buttons
The three HK (hot-key) Buttons allow you instant access to your defa
ternet browser and default e-mail program, and to toggle on/off the W
LAN/Bluetooth/PC Camera modules (by using the Module ON/OFF B
- see below). To learn how to set the buttons, see “HK Buttons” on p
15.

Module ON/OFF Button
If your computer has a Wireless LAN module and/or Bluetooth and
Camera modules, you can use this HK Button to turn the modules 
OFF. To enable the modules you will need to install the drivers/softw
them (see “Mini-PCI Wireless LAN Module” on page 7 - 2, “Blu
Module” on page 7 - 6 & “PC Camera” on page 7 - 11). Make su
wireless modules are OFF when you are using the computer aboa
craft (see sidebar).

1
2

1
Module ON/OFF Button
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ok from overheating.

 allow dual video or simultaneous
(see “Display Devices & Options”

5

67

3 4

g

ake sure nothing blocks the vent/fan
- 14 Left Side View

Left Side View

Vent
This enables airflow to prevent the notebo

External Monitor Port
Connect an external monitor to this port to
display on the LCD and external monitor 
on page 3 - 7).

1 2

Figure 1 - 7
Left Side View

1. Vent
2. External Monitor 

Port
3. RJ-11 Phone Jack
4. RJ-45 LAN Jack
5. 2 * USB 2.0 Ports
6. PC Card Slot
7. PC Card Eject 

Button
Overheatin

To prevent your computer from overheating m
intake while the computer is in use.
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DSL)
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r high-
-speed
d from
ting of
supply

so pre-
to “PC
RJ-11 Phone Jack
This port connects to the built-in modem. You may plug the telephone 
rectly into this RJ-11 telephone connection. Note: Broadband (e.g. A
modems usually connect to the LAN port.

RJ-45 LAN Jack
This port supports LAN (Network) functions. Note: Broadband (e.g. A
modems usually connect to the LAN port.

2 * USB 2.0 Ports
These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant)
low-speed peripherals such as keyboards, mice or scanners, and fo
speed peripherals such as external HDDs, digital video cameras or high
scanners etc. Devices can be plugged into the computer, and unplugge
the computer, without the need to turn the system off (if the power ra
your USB device is 500mA or above, make sure you use the power 
which comes with the device).

PC Card Slot
The 3.3V/5V slot may be used for a Type-II PC card (PC cards were al
viously referred to as PCMCIA) and fully supports Cardbus. Refer 
Card Slot” on page 2 - 14 for more information.
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n external microphone.

 jack. Note: Set your system’s vol-
o this jack.

terface Format) jack allows you to
AC-3 compatible receiver for “5.1”

5

- 16 Right Side View

Right Side View

Microphone-In Jack
Record on your notebook computer with a

Headphone-Out Jack
Headphones may be connected through this
ume to a reduced level before connecting t

S/PDIF-Out Jack
This S/PDIF-Out (Sony/Philips Digital In
connect your DVD-capable PC to a Dolby 
or ‘dts’ surround sound.

1 2 3 4

Figure 1 - 8
Right Side View

1. Microphone-In Jack
2. Headphone-Out 

Jack
3. S/PDIF-Out Jack
4. CD Device Bay
5. DC-In Jack
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Optical Device Bay
The optical device bay will contain a 5.25" CD/DVD type optical devi
the device type is dependent on your purchase option (see “Option
page A - 6).  For more information on using the drive please refer to “O
(CD/DVD) Device” on page 2 - 10.

DC-In Jack
Plug the supplied AC adapter into this jack to power your notebook.

CD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power inte
tion) you may push the end of a straightened paper clip into the emergency 
hole. Do not use a sharpened pencil or similar object that may break and bec
lodged in the hole.
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pe lock can be attached to this slot.
tore.

ok from overheating.

2

- 18 Rear View

Rear View

Security Lock Slot
To prevent possible theft, a Kensington-ty
Locks can be purchased at any computer s

Vent
This enables airflow to prevent the notebo

Figure 1 - 9
Rear View

1. Security Lock Slot
2. Vent

Overheating

To prevent your com-
puter from overheating
make sure nothing
blocks the vent/fan
outlet while the com-
puter is in use.

1
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Figure 1 - 10
Bottom View

1. Vent/Fan Intake 
2. Battery
3. CPU Cover
4. RAM & WLAN 

Module Cover 
(Model A)

5. Optical Device 
Screw Cover 

6. Hard Disk Module 
Cover (Model A)

7. Hard DIsk, RAM & 
WLAN Module 
Cover (Model B)

user
art.
art-
 the
may
ty.

om-
ting
ing
 in-
put-
Bottom View

5

2

1

3

6                                                                                                                                                4                                                                                                                                                

1

1

CPU

The CPU is not a 
serviceable p
Opening this comp
ment, or accessing
CPU in any way, 
violate your warran

Overheating

To prevent your c
puter from overhea
make sure noth
blocks the vent/fan
take while the com
er is in use.

Model A

Model B

7

1

1

15

1
1

2
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1

ok from overheating.

 for instructions on battery use and

e your data. See page 6 - 4 for in-
d disk drive.

oth Modules
(s), make sure to install the driver
odules” on page 7 - 1 and sidebar

ing

 the system is on. This could cause
r tampering with the HDD may violate
r service representative.
- 20 Bottom View

Vent/Fan Intake
This enables airflow to prevent the notebo

Battery
See “Battery Information” on page 3 - 20
care.

Hard Disk Drive
The internal hard disk drive is used to stor
formation on upgrading/replacing your har

Wireless LAN (Network) & Blueto
 If your configuration includes the module
(see “Wireless, Bluetooth & PC Camera M
note).

Drive Warn

Don’t try to remove the hard disk (HDD) while
data loss or damage. Unauthorized removal o
your warranty. If you are in doubt, consult you

Wireless LAN & 
Bluetooth Modules

The Wireless LAN and
Bluetooth modules
(and the optional PC
Camera module) may
be enabled and dis-
abled by pressing the
button at the front of
the computer (see
“Module ON/OFF
Button” on page 1 -
13).
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Chapter 2: Using The Compute
Overview
To learn more about using your computer, please read this chapter.

This chapter includes:

• The Power Sources
• Turning on the Computer
• The LED Indicators
• The Auto Mail Checker
• The Hard Disk Drive
• The Optical (CD/DVD) Device
• The PC Card Slot
• The HK Buttons
• The Function Keys & Numeric Keypad
• The TouchPad & Buttons/Mouse
• Adding a Printer (general guidelines)
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2
 AC adapter or a battery pack.

your computer. The wrong type of
 its components.

 on the right of the computer.
nd then connect the AC power cord 

ing angle.

ok computer while you are on the
attery life varies depending on the
ing. To increase battery life, let the
ging. 

e battery. For more information on
ation” on page 3 - 20.
- 2 The Power Sources

The Power Sources
The computer can be powered by either an

AC Adapter
Use only the AC adapter that comes with 
AC adapter will damage the computer and

1. Attach the AC adapter to the DC-In jack
2. Plug the AC power cord into an outlet, a

to the AC adapter.
3. Raise the lid/LCD to a comfortable view
4. Press the power button to turn “on”.

Battery
The battery allows you to use your notebo
road or an electrical outlet is unavailable. B
applications and the configuration you're us
battery discharge completely before rechar

We recommend that you do not remove th
the battery, please refer to “Battery Inform

Power Button as 
Standby or Hibernate 

Button

If you are using a fully
ACPI-compliant OS,
(such as Windows
2000 Professional, or
Windows XP) you can
use the OS’s “Power
Options” control panel
to set the power button
to send the system into
Standby or Hibernate
mode (see your OS’s
documentation, or
“Configuring the
Power Button” on
page 3 - 19 for de-
tails).
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2ed and
 use, it
uter is
s. (Re-
charge
tion on

lode

Battery Removal

We recommend that
you do not remove the
battery yourself.
Please consult your
service representative
should you need to re-
move the battery for
any reason.
Low Battery Warning

When the battery is
critically low, immedi-
ately connect the AC
adapter to the comput-
er or save your work,
otherwise, the un-
saved data will be lost
when the power is de-
pleted.

after
shut
 has
uter
age,
uter
Recharging the Battery with the AC Adapter
The battery pack automatically recharges when the AC adapter is attach
plugged into an electrical outlet. If the computer is powered on, and in
will take several hours to fully recharge the battery. When the comp
turned off but plugged into an electrical outlet, battery charge time is les
fer to “LED Indicators” on page 2 - 5 for information on the battery 
status, and to “Battery Information” on page 3 - 20 for more informa
how to maintain and properly recharge the battery pack.)

Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may exp
• DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape 
being dropped), or any unusual smells emanating from the notebook battery, 
your computer down immediately and contact your service center. If the battery
been dropped we do not recommend using it any further, as even if the comp
continues to work with a damaged battery in place, it may cause circuit dam
which may possibly result in fire. It is recommended that you replace your comp
battery every two years.
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2 r
mputer. To turn it on simply press

 power button as a Standby/Hiber-
 pressed for less than 4 seconds
 longer than this will shut the com-
indows control panel to configure

ff

 key combination doesn’t work, press
 force the system to turn itself off.
- 4 Turning on the Computer

Turning on the Compute
Now you are ready to begin using your co
the power button on the front panel.

When the computer is on, you can use the
nate/Shutdown hot-key button when it is
(pressing and holding the power button for
puter down). Use Power Options in the W
this feature.

Shutdown

Note that you should
always shut your com-
puter down by choos-
ing the Shut Down/
Turn Off Computer
command from the
Start menu in Win-
dows. This will help
prevent hard disk or
system problems.

Forced O

If the system “hangs”, and the Ctrl + Alt + Del
the power button for 4 seconds, or longer, to
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y help-
wer &
mputer
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rLk)

Figure 2 - 1
LED Indicators

Table 2 - 1
LED Status 
Indicators

Scroll Lock

To enable and disable
the Scroll Lock feature,
press the Fn and
ScrLk keys simultane-
ously.
LED Indicators
There are two sets of LED indicators (LED Power & Communication
cators and LED Status Indicators) on your computer that will displa
ful information about the current status of the computer. The LED Po
Communication Indicators are also visible when the top of your co
is closed.

LED Status Indicators
Icon Color Description

Green Hard Disk/CD Device activity

Green The Module(s) (WLAN, PC Camera, Bluetooth) is/a

Green Number Lock is activated

Green Caps Lock is activated

Green Scroll Lock is activated (to activate press Fn & Sc

Power & Communication Indicators LED Status IndicatorsLED Status Indicators
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2 Indicators

Description

C power is plugged in

The computer is on

omputer is in standby mode 

 battery is being charged

e battery is fully charged

s reached critically low power status

New mail has arrived
- 6 LED Indicators

LED Power & Communication 

Icon Color

Orange D

Green

Blinking Green The c

Orange The

Green Th

Blinking Orange The battery ha

Blinking Green

Table 2 - 2
LED Power & 

Communication 
Indicators



Using The Computer

Auto Mail Checker 2 - 7
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am(see
u noti-
is noti-
d your

 do not
 Auto
l bring
t data, Figure 2 - 2

Auto Mail Checker 
(Startup Menu)
Auto Mail Checker
After you have installed the driver for the Auto Mail Checker progr
“What to Install” on page 4 - 1) you may then configure it to give yo
fication when you receive new mail. You must be online to receive th
fication (note that this program only supports the POP3 protocol), an
default mail program does not need to be open.

The Auto Mail Checker appears as an icon  in the taskbar (if you
see the icon in the taskbar go to Start > Programs/All Programs >
Mail Checker > Auto Mail Checker). Right clicking on the icon wil
up the following options menu. If you have not input your mail accoun
then you will be prompted to do so.

Select Open to bring up the control panel for the program.
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2
r mailserver, name, password, pro-
- 8 Auto Mail Checker

You may then configure the options for you
gram and method(s) of notification.

Note

Check with your Inter-
net Service Provider,
network administrator
or Mail Service provid-
er for details on what to
put on these pages.

Figure 2 - 3
Auto Mail Checker 
Account Setup and 

Options
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2
er. The
 drives

en be-
able in

Power Safety

Before attempting to
access any of the inter-
nal components of
your notebook please
ensure that the ma-
chine is not connected
to the AC power, and
that the machine is
turned off. Also ensure
that all peripheral ca-
bles, including phone
lines, are disconnected
from the computer.

Figure 2 - 4
Hard Disk Location
Hard Disk Drive
The hard disk drive is used to store your data in the notebook comput
hard disk can be taken out to accommodate other 2.5" IDE hard disk
with a height of 9.5 mm.

The hard disk  is accessible from the bottom of your computer as se
low. Further details on removing and inserting the hard disk are avail
“Upgrading the Hard Disk Drive” on page 6 - 4.

1

Hard Disk

1
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2 e
 CD/DVD type optical device. The
on you purchased. The optical de-
y be used as a boot device if prop-
 page 5 - 12).

  and carefully place a CD/DVD
 (use just enough force for the disc
h the CD/DVD tray in until its lock
sy indicator  will light up while
/video CD, or DVD, is playing. If
n object such as a straightened pa-
o open the tray.

1

2

2
3

- 10 Optical (CD/DVD) Device

Optical (CD/DVD) Devic
The optical device bay will contain a 5.25"
actual device type will depend on the opti
vice is usually labeled “Drive D:”, and ma
erly set in the BIOS (see “Boot Menu” on

Loading Discs
To insert a CD/DVD, press the open button
onto the disc tray with label-side facing up
to click onto the tray’s spindle). Gently pus
“clicks” and you are ready to start. The bu
data is being accessed, or while an audio
power is unexpectedly interrupted, insert a
per clip into the emergency eject hole  t

Sound Volume 
Adjustment

How high the sound
volume can be set de-
pends on the setting of
the volume control
within Windows. Click
the Speaker icon on
the taskbar to check
the setting. 

All peripherals must be
connected before you
turn on the system.

Figure 2 - 5
CD Device

3

1
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2aged.
ur CD-

disc.

VD.

CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency
eject hole. However
please do NOT use a
sharpened pencil or
similar object that may
break and become
lodged in the hole.
O

Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being dam
Please follow the advice below to make sure that the data stored on yo
ROMs/DVD-ROMs can be accessed.

Remember to:

• Hold the CD or DVD by the edges; do not touch the surface of the 
• Use a clean, soft, dry cloth to remove dust or fingerprints
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or D
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.
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2 , not OS-dependent. You can select
th selection is permanent. This can-
ating system or you use the module
- 12 Optical (CD/DVD) Device

DVD Regional Codes
DVD region detection is device dependent
your module’s region code 5 times. The fif
not be altered even if you change your oper
in another computer. 

Figure 2 - 6
DVD Regional Codes

(Windows XP)
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Table 2 - 3
DVD Regional Coding
O

Changing DVD Regional Codes
Go to the Control Panel in WindowsXP/Windows 2000 and double-clic
tem > Hardware (tab), click Device Manager, then click the + next to
CD-ROM drives. Double-click on the DVD-ROM device to bring 
Properties menu, and select the DVD Region (tab) to bring up the 
panel as seen in “DVD Regional Codes (Windows XP)” on page 2 - 1

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South Africa, Middle East & Egypt

3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, 
Kong

4 South & Central America, Mexico, Australia, New Zealand

5 N Korea, Russia, Eastern Europe, India & Most of Africa

6 China
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 3.3V/5V slot for one type II PC

he PC Card (see “What to Install”

rds 
h it in until it locks into place.

 eject button  next to the slot.1
- 14 PC Card Slot

PC Card Slot
The computer is equipped with a PCMCIA
Card. Make sure you install the driver for t
on page 4 - 1).

Inserting and Removing PC Ca
• Align the PC Card with the slot and pus
• To remove a PC Card, simply press the

Figure 2 - 7
PC Card Slot

1



Using The Computer

HK Buttons 2 - 15

2
e mod-
ke sure
ll” on

 quick

mera 

Table 2 - 4
HK Buttons
HK Buttons
These buttons access the Internet and e-mail, and to enable/disable th
ule(s) (WLAN/Bluetooth/PC Camera) with one quick button press. Ma
you install the HK (Hot-Key) Buttons driver. Refer to “What to Insta
page 4 - 1 for driver installation steps.

My Computer Key
The My Computer Key  at the bottom left of the keyboard gives you
one button access to the My Computer folder on your computer.

Programming the HK Buttons

HK Buttons Function

Activate the default Internet browser

 Activate the default e-mail program

Toggle power to the module(s) - (Wireless LAN/Bluetooth/PC Ca
modules)
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2 eric Keypad

n key or Function key. The Fn key
nstantly. To use the functions press
priate function key (F5 - F12 etc.)

escription

unction Key

/Resume Toggle

ute Toggle

splay Toggle

e LCD Brightness

e LCD Brightness

se Audio Volume

e Audio Volume

ll Lock Toggle
- 16 Function Keys and Numeric Keypad

Function Keys and Num

Function Keys
On the bottom-left of the keyboard is the F
allows you to change operational features i
and hold the Fn key, then press the appro
located on your keyboard.

Keys D

Fn F

Fn + Esc Sleep

Fn + F5  M

Fn + F6 Di

Fn + F9 Decreas

Fn + F10  Increas

Fn + F11 Decrea

Fn + F12 Increas

Fn + Scr Lk Scro

Other Keyboards

If your keyboard is
damaged or you just
want to make a
change, you can use
any standard USB key-
board. The system will
detect and enable it
automatically. Howev-
er special functions/hot
keys unique to the sys-
tem’s regular keyboard
may not work.

Table 2 - 5
Function Keys
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2 input.

the top
 not by
2 - 5).
abled.

ess the

Special Characters

Some software appli-
cations allow the
number-keys to be
used with Alt to pro-
duce special charac-
ters. These special
characters can only be
produced by using the
numeric keypad. Reg-
ular number keys (in
the upper row of the
keyboard) will not
work. Make sure that
Num Lock is on.

Figure 2 - 8
Keyboard

 

Function Key

Numeric Keypad
The keyboard has an embedded numerical keypad for easy numeric data
The numeric keys are highlighted by a yellow typeface.
Activate the Number Lock feature by pressing the Num Lock key at 
right of the keyboard. You may check if Number Lock is enabled or
looking at the LED status indicators (see “LED Indicators” on page
To type a number from the numeric keypad make sure Num Lock is en

Activate Scroll Lock by pressing and holding the Fn key, and then pr
Scr Lk key at the top right of the keyboard.

Numeric Keypad

Fn Key

Function Keys

Num Lock &

My Computer Key

Scr Lk Keys
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use; however, you can also add a
 USB ports. The TouchPad buttons
tton mouse. The central button may

uttons
er you can configure the functions
on  on the taskbar, or by going
art menu and point to Settings and
 Mouse icon). In Windows XP the
 Other Hardware Category.
- 18 TouchPad and Buttons/Mouse

TouchPad and Buttons/
The TouchPad is an alternative to the mo
mouse to your computer through one of the
function in much the same way as a two-bu
be configured to function as you require.

Configuring the TouchPad and B
Once you have installed the TouchPad driv
by double-clicking the TouchPad driver ic
to the Mouse control panel in Windows (St
click Control Panel, then double-click the
Mouse control panel is in the Printers and

Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only ena-
ble its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

Figure 2 - 9
Mouse Properties
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Adding a Printer
The most commonly used peripheral is a printer. The following conv
will help you to add a printer, however it is always best to refer to the
manual for specific instructions and configuration options.

USB Printer
Most new printers have a USB interface connection. You may use eithe
USB ports on your computer to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray

ink cartridge etc.). 
2. Turn ON the computer.
3. Turn ON the printer. 
4. Connect the printer’s USB cable to one of the USB ports on the com
5. Windows will identify the printer and either load one of its own drivers

you to supply one. Follow the on-screen instructions.



Using The Computer

2

2 nter. A Parallel to USB converter
.

ctions (unpacking, paper tray, toner/

e Parallel to USB converter, and 
rt.

 require a driver to recognize the 
 printer and either load one of its 
ollow the on-screen instructions.
- 20 Adding a Printer

Parallel Printer
This is still the most common type of pri
may be purchased at most computer stores

Install Instructions:
1. Set up the printer according to its instru

ink cartridge etc.).
2. Attach the parallel cable to the printer.
3. Connect the printer’s parallel cable to th

then plug the converter into the USB po
4. Turn ON the printer.
5. Turn ON the computer.
6. Windows (some operating systems may

parallel to USB adapter) will identify the
own drivers or ask you to supply one. F



Advanced Controls

Overview 3 - 1

3

crosoft

Drivers

You are unable to use
most advanced con-
trols until the neces-
sary drivers and
utilities are properly in-
stalled. If your system
hasn’t been properly
configured (your ser-
vice representative
may have already
done that for you), re-
fer to “What to In-
stall” on page 4 - 1 for
installation instruc-
tions.
Chapter 3: Advanced Controls
Overview
This chapter covers:

• Advanced Video Controls
• Power and Battery Management Features

Note: All operating system pictures in this manual are from the Mi
Windows XP OS.
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3

ls
or the LCD, and switching display

eo memory, but automatically and
4MB maximum) system memory
 video driver must be installed -
ystem returns whatever memory is
and is not user configurable.

k at the screen straight on, without
ss controls (Fn + F9/F10).

F10
- 2 Advanced Video Controls

Advanced Video Contro
This section is about making adjustments f
devices.

Video Memory
The system does not feature dedicated vid
dynamically allocates as much (up to 6
(RAM) as needed to the video system (the
see “What to Install” on page 4 - 1). The s
no longer needed to the operating system, 

Opening the LCD
As you open the lid, adjust it so you can loo
any glare. If necessary, adjust the brightne

Protecting the LCD

Do not allow any for-
eign objects (i.e. paper
or plastic) to get be-
tween the lid/LCD and
the work panel. They
could damage or
scratch the LCD and/or
accidentally activate
the Lid Sensor.

Figure 3 - 1
Brightness 

Controls

Fn

F9
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3
tput to
dware,
terface

anel in
ll” on

e LCD
h go to

ontrol 
s).

setting 

tting 

Screen Resolution/
Screen Area Note

You may set the reso-
lution to a higher set-
ting than the panel
supports, however this
will require you to pan
(scroll) around the
screen as the display
area will be larger than
what you can see on
the LCD.
Display Properties
The video interface lets you change the screen resolution and color ou
whatever is most comfortable/efficient for you. This is a matter of har
video memory and the driver for your operating system. The driver in
shows the available options (see pages  A - 3 for LCD information).

You configure display devices from the Display Properties control p
Windows as long as the video driver is installed (see “What to Insta
page 4 - 1).

Making Adjustments for the Display
The higher the resolution you set the LCD for, the more information th
can display on screen. To change the LCD’s resolution and color dept
the Display Properties control panel:

1. Click Start, point to Settings (or just click Control Panel) and click C
Panel (if you are in Category View choose Appearance and Theme

2. Double-click Display (icon).
3. In the Display Properties dialog box, click Settings (tab).
4. In Screen area/Screen resolution, move the slider to the preferred 

for resolution (see  in Figure 3 - 2 on page 3 - 4).
5. In Colors/Color quality, click the arrow and scroll to the preferred se

for color depth (see  in Figure 3 - 2 on page 3 - 4).

1

2
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el is open, click the Advanced 
ing through these tabs allows you
.

3

- 4 Display Properties

When the Display Properties control pan
(button) to bring up the options tabs. Click
to make any video adjustments you require

Figure 3 - 2
Display Properties

&
Advanced Options

2

3

1
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3
ble. To

ontrol 

e. 
Figure 3 - 3

SiS Utility Tray Icon 
Menu & SiS Utility 

Manager
SiS Utility Tray/Manager
With the video driver installed additional control panels are availa
get to the control panels do the following: 

1. Click Start, point to Settings (or just click Control Panel) and click C
Panel.

2. Double-click Display (Icon).
3. In the Display settings dialog box, click Settings (tab).
4. Click Advanced (button), and click SiS Utility Manager (tab).
5. Choose the setting you wish to change.
                                            OR
1. Right-Click the SiS Utility Tray icon in the taskbar.
2. Point to Display Property and choose the setting you wish to chang

SiS Utility Tray Icon
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e Settings, Video Settings, Gamma
rmation by clicking the appropriate
 OK.
- 6 Display Properties

You may make changes to the Driver Mod
Correction Settings, and view General Info
tab and adjusting the setting, then clicking

Figure 3 - 4
SiS M661MX 

Controller Properties
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d (see

e 

0 Table 3 - 1
Display Options
Dis

Display Devices & Options
Besides the built-in LCD, you can also use an external monitor conne
the external monitor port (see Figure 1 - 7 on page 1 - 14). The followin
er mode settings are available as long as the video driver is installe
“What to Install” on page 4 - 1):

1. The built-in LCD (Single).
2. A monitor connected to the external monitor port on the left side of th

computer (Single).
3. The built-in LCD and a monitor showing the same image (Mirrored).
4. The built-in LCD and a monitor showing different images (Extended 

Desktop - Not Available in Windows 2000).

Driver Mode Setting Windows XP Windows 200

Single

Mirrored

Extended Desktop Not Available
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eyboard)
le other devices, use the Fn + Dis-

rt.
neously pressing the F6 key.
isplay the LCD only, the LCD and 
ternal display alone (make sure you 
you toggle through).

 to switch through the display op-
on options available to you. If you
y Devices & Options” on page 3 -
the settings as per “Switching/En-
- 8 Display Devices & Options

Switching/Enabling Displays (K
To simply switch display devices, or enab
play (F6) toggle do the following:

1. Plug the monitor into the appropriate po
2. Press and hold the Fn key, while simulta
3. You may toggle through the options to d

the external display together, and the ex
allow time for the screens to refresh as 

Note: If you only use the keyboard toggle
tions you will not have all the configurati
want to access the options listed in “Displa
7 use the driver control panel to configure 
abling Displays (Driver)” on page 3 - 9.
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3
ontrols

ray/

lay 

Figure 3 - 5
Driver Mode 

Setting Control 
Panel
Dis

Switching/Enabling Displays (Driver)
Use the video driver’s (see “What to Install” on page 4 - 1) built-in c
to switch between the displays as follows:

1. Plug the external monitor into the appropriate port.
2. Go to the SiS Utility Manager (see the instructions in “SiS Utility T

Manager” on page 3 - 5), and choose Driver Mode Setting.
3. If the device list box doesn’t show any plugged in devices, click Disp

devices detection (button), and click to put a check in Power on 
secondary device (box).

4. Click OK > OK, and Yes to keep the settings.
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3
act copy of the Primary display
 this feature to display the screen

indows 2000) allows the desktop
rea, thus creating a lot more screen
 configured independently for spe-

red  and Extended Desktop 
 Setting control panel.

de
x

in2000)
- 10 Display Devices & Options

Driver Mode Setting
A Mirrored desktop simply shows an ex
desktop on the Secondary display(s). Use
through a projector for a presentation etc.

An Extended desktop (not available in W
to span the displays to act as a large work a
area for display. Each display device can be
cific resolutions and refresh rates.

You can switch the display between Mirro
modes by clicking the icon in Driver Mode

Figure 3 - 6
Mode Setting 

Options

Driver Mo
Toggle Bo

(Not Available in W
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 - see 

Support Mode Note

You may configure the
resolution and refresh
rate for both display
devices in Extended
Desktop mode only.

In Mirrored mode you
may only configure the
resolution and refresh
rate for the Primary
display device (LCD or
CRT).

See page 3 - 12 for fur-
ther instructions on en-
abling and configuring
Extended Desktop
mode.

Figure 3 - 7
Support Modes
Disp

Configuring the Driver Mode Setting
1. Plug the external monitor into the appropriate port.
2. Go to the SiS Utility Manager (see the instructions in “SiS Utility T

Manager” on page 3 - 5), and choose Driver Mode Setting.
3. If the device list box doesn’t show any plugged in devices, click Disp

devices detection (button), and click to put a check in Power on 
secondary device (box).

4. Click either the Mirrored  or Extended Desktop  icon to toggle
between the display modes.

5. Click OK > OK, and Yes to keep the settings.
6. Use the dropbox to switch the Primary and Secondary displays betw

the LCD and CRT (external monitor).
7. Use the Support Modes dropbox (in Extended Desktop mode only

sidebar) to configure the resolution and refresh rates etc.
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 Properties - WinXP Only)
priate port.
ontrol Panel (or click Control 

 Category View choose 

lick Settings (tab).
), and make sure you have 

p onto this monitor.” and click 

rs to match the physical 
mple shown in Figure 3 - 9 the 

ondary display is on the right.

2

lick the appropriate
onitor icon to be able to
lect the option to extend
e desktop on to it.
- 12 Display Devices & Options

To Enable Extended Desktop (Display
1. Plug the external monitor into the appro
2. Click Start, point to Settings and click C

Panel).
3. Double-click Display (icon); if you are in

Appearance and Themes.
4. In the Display Properties dialog box, c
5. Click the appropriate monitor icon (e.g. 

checked “Extend my Windows deskto
Apply.

6. Use the control panel to drag the monito
arrangement you wish to use. In the exa
primary monitor  is on the left; the sec

Figure 3 - 8
Display Properties 
(Extended Desktop 

Mode)

Extended Desktop 
Configuration

You can drag any
icons or windows
across to either display
desktop, which makes
it possible to have one
program visible in one
of the displays, and a
different program visi-
ble in the other display.

C
m
se
th

1
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3
omput-
serves

tor and

g tech-
er and

S to set
om ap-
.

OS Note

Power management
functions will vary
slightly depending on
your operating system.
For more information it
is best to refer to the
user’s manual of your
operating system. 

(Note: All pictures
used on the following
pages are from the
Windows XP OS.)
Power

Power Management Features
To conserve power, especially when using the battery, your notebook c
er uses the ACPI power management system. Power management con
power by controlling individual components of the computer (the moni
hard disk drive) or the whole system.

Advanced Configuration and Power Interface
The ACPI interface provides the computer with enhanced power savin
niques and gives the operating system (OS) direct control over the pow
thermal states of devices and processors. For example, it enables the O
devices into low-power states based on user settings and information fr
plications. ACPI is fully supported in Windows 2000 and Windows XP
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3
ontrol panel in your Windows sys-
ing systems you may have power
mentation.

ual components or throughout the
- 14 Enabling Power Options

Enabling Power Options
Power Options are enabled through the c
tem (Power Options). With other operat
management available, so check your docu

You may conserve power through individ
whole system.

Figure 3 - 9
Power Options
Control Panel
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3
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r each
puter's
d for a
 motor
d time
 Power

Resuming Operation

The system can re-
sume from Monitor or
Hard Disk Standby by
pressing a key on the
keyboard.

Figure 3 - 10
Power Schemes
E

Power Schemes
You can set your computer to conserve power through individual comp
by means of Power Schemes. You can also adjust the settings fo
scheme to set the monitor to turn off after a specified time, and the com
hard disk motor to turn off if the hard disk drive has not been accesse
specified period of time (if the system reads or writes data, the hard disk
will be turned back on). The schemes may also be set to set a specifie
for the system to enter Standby or Hibernate modes (see “Conserving
(System)” on page 3 - 17).
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djust the processor performance of
is worth bearing in mind if you are
pecially under DC/battery power).

r maximum performance when the
source. Choose the Max Battery
ay slow down the overall perfor-

ower) for maximum power saving
powered.

 default scheme.
- 16 Enabling Power Options

Each Windows Power Scheme will also a
your machine in order to save power. This 
experiencing any reduced performance (es

Choose the Home/Office Desk scheme fo
computer is powered from an AC power 
scheme (bear in mind that this scheme m
mance of the computer in order to save p
when the computer is battery (DC power) 

Windows will use Portable/Laptop as the
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Conserving Power (System)
With this function you can stop the notebook’s operation and restart
you left off. This system features Standby and Hibernate sleep mode
(Hibernate mode will need to be enabled by clicking the option in the 
nate tab in the Power Options control panel - Figure 3 - 12 on page 3

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off a
need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you l
off (what was on your desktop) without reopening the application(
file(s) you last used.

You can use either method depending on your needs. 

Standby Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put t
tem on standby instead of in hibernation. It takes a longer time to wake
system from Hibernate mode than from Standby mode.
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3
ut takes the shortest time to return

 disk is turned off, and the CPU is
applications are retained in memo-
 for a certain length of time, which
enter Standby mode to save power. 

 your information on a part of the
gh it saves the most power it takes

. You can set your notebook to au-
e battery power is almost depleted.
om the Hibernate tab in the Power
esume from Hibernate mode by
- 18 Enabling Power Options

Standby
Standby saves the least amount of power, b
to full operation. During Standby the hard
made to idle at its slowest speed. All open 
ry. When you are not using your computer
you specify in the operating system, it will 
Hibernate
Hibernate uses no power and saves all of
HDD before it turns the system off. Althou
the longest time to return to full operation
tomatically enter Hibernate mode when th
You will need to enable Hibernate mode fr
Options control panel. The system will r
pressing the power button.

System Resume

The system can re-
sume from Standby
mode by:

• Pressing the power
button

• Pressing the key
combination Fn +
Esc

• An alarm resume
that is enabled and
expires

• An incoming call
received on the
modem

Figure 3 - 11
Enable Hibernation
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3
 or Hi-
Hiber-
to save
D will

Lid Sensor

If you have set your
computer to enter
Standby mode when
the lid (“when I close
the lid of my portable
computer:”) of the
computer is closed
(the Lid Sensor de-
tects when the lid/LCD
panel is closed), the
system will not resume
normal operation when
the lid is opened.
Press a key on the
keyboard to resume
operation.

Figure 3 - 12
Power Options

(Advanced - Power 
Buttons)

Button

 the
tton.
E

Configuring the Power Button
The power button may be set to send the computer in to either Standby
bernate mode. In Standby mode, the LED  will flash green. In 
nate mode the LED will be off. If you are in a power saving mode set 
power through individual components (e.g. hard disk, monitor), the LE
remain green.

Power Button Sleep/Resume(Sleep)Lid Sensor

Sleep Button

You may also configure the Sleep/Resume key combination (Fn + Esc) from
menu illustrated in Figure 3 - 13. In Windows this is referred to as the Sleep bu
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t the best use out of your battery.

harge, a new battery (see “Battery
ow to do this).

 upon many factors, including the
 devices attached. Power Options
ions, and check the Power Meter
d settings in the OS will help pro-

ately.
- 20 Battery Information

Battery Information
Please follow these simple guidelines to ge

New Battery
Always completely discharge, then fully c
FAQ” on page 3 - 21 for instructions on h

Battery Life
Your computer’s battery life is dependent
programs you are running, and peripheral
(you may set low battery Alarms and act
from the Power Options control panel), an
long the battery life if configured appropri

Caution

Danger of explosion if
battery is incorrectly
replaced.

Replace only with the
same or equivalent
type recommended by
the manufacturer. Dis-
card used battery ac-
cording to the
manufacturer’s in-
structions.

Figure 3 - 13
Power Options 
(Alarm & Power 

Meter)
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ize the
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need to
e 6 - 3.

attery.
that in-
he bat-
nctions
s) and
d of its

r light

s or af-

Conserving Battery 
Power

To conserve battery pow-
er:

Lower the brightness lev-
el of the LCD display. The
system will decrease LCD
brightness slightly to save
power when it is not pow-
ered by the AC adapter.
Close modem or commu-
nication applications
when they are not being
used.
Remove any unused PC
Cards from the computer
(PC Cards quickly use up
battery power even if the
system enters sleep
mode).
Disconnect any unneces-
sary external devices.
Battery life may be shortened through improper maintenance. To optim
life and improve its performance, fully discharge and recharge the ba
least once every 30 days.

We recommend that you do not remove the battery yourself. If you do 
remove the battery for any reason see “Removing the Battery” on pag

Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low b
Don’t turn off the computer by yourself even when you see a message 
dicates the battery is critically low, just let the computer use up all of t
tery power and shut down on its own. Disable the Power Options fu
in the Control Panel, especially any Alarms (unclick the tickboxe
Schemes (change all the settings to Never). As the battery nears the en
life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicato
changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 day
ter about 20 partial discharges.
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Drivers & Utilities

Overview 4 - 1

4

all
vers & Utilities + User’s Manual
ins the drivers and utilities neces-
er operation of the computer. (The

ess LAN module, optional Blue-
d optional PC Camera drivers are
-ROMs supplied.) Table 4 - 1 on
what you need to install manually
r choice of the operating system. It
nt that the drivers are installed in
ted in the table.

er Installation
for installing drivers for the Wire-
amera and Bluetooth modules are
ireless, Bluetooth & PC Camera
ge 7 - 1. Make sure that the drivers
e order indicated in Table 4 - 1 on
Chapter 4: Drivers & Utilities
Overview
This chapter deals with installing the drivers and
utilities essential to the operation or improvement
of some of the computer’s subsystems. The system
takes advantage of some newer hardware compo-
nents for which the latest versions of most available
operating systems haven’t built in drivers and utili-
ties. Thus, some of the system components won’t
be auto-configured with an appropriate driver or
utility during operating system installation. Instead,
you need to manually install some system-required
drivers and utilities. In this chapter, we group driver
and utility installation instructions by operating
system. The following operating systems are cov-
ered.

• Windows 2000 Professional
• Windows XP Professional and Home Editions

What to Inst
The Device Dri
CD-ROM conta
sary for the prop
optional Wirel
tooth module an
on separate CD
page 4 - 7 lists 
according to you
is very importa
the order indica

Module Driv
The procedures 
less LAN, PC C
provided in “W
Modules” on pa
are installed in th
page 4 - 7.
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4

- Navigate (Browse..) to.. 
- 2 Overview

Navigate (Browse..) to D:

You will notice that many of the instructions for driver
installation require you to “Navigate (Browse) to D:”.
We assume that you will install all drivers and utilities
from the built-in CD device and it is assigned to “Drive
D:”. In addition, all file extensions can be seen

In this case “D:” is the drive specified for your CD de-
vice. Not all computers are setup the same way, and
some computers have the CD listed under a different
drive letter - e.g. if you have two hard drives (or hard
disk partitions) one may be designated as “Drive C:”
and the other as “Drive D:”. In this case the CD device
may be designated as “Drive E:” - Please make sure
you are actually navigating to the correct drive letter
for the CD device.

When you click the Browse (button) after clicking
Run in the Start menu you will see the “Look in:” di-
alogue box at the top of the Browse window. Click the
scroll button to navigate to My Computer to display
the devices and drive letters.

Figure 4 - 1 
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4

ows 2000 Service Pack 4

t your Windows 2000 version in-
 Pack 4 on the installation CD as this
rt for USB 2.0.
Service Packs
Check the warnings on the following pages regard-
ing installation of the appropriate Service Pack for
your Windows OS. If you are unsure of the Service
Pack currently installed see below. Make sure you
have installed the appropriate Service Pack before
installing all the drivers.

Service Pack Installed

To see which Service Pack is currently installed on
your computer go to the General tab of the System
control panel. Right-click the My Computer icon on
the desktop or in the Start menu (in WinXP only) and
select Properties. The Service Pack currently in-
stalled on your system will be listed under the “Sys-
tem:” heading. (If no Service Pack information is
listed, then no Service Pack is installed.)

Wind

Make sure tha
cludes Service
includes suppo
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4
ion which includes Service Pack 2)
.
ndows XP version does not include

e My Computer icon go to step 2)
 and scroll down to Properties and

 (but don’t click just highlight it) My
roperties and click on it (go to step

 OK.
- 4 Overview

Windows XP Service Pack 2

Make sure you install Windows XP Service Pack 2(or a Windows XP vers
before installing any drivers. Service Pack 1 includes support for USB 2.0
If you have upgraded the system by installing Service Pack 2 (i.e. your Wi
Service Pack 2) then follow these instructions:

1.If you can see the My Computer icon on your desktop (if you cannot see th
click on it once to select it, then right-click it to make the sub-menu appear
click on it (go to step 3).

2.If you cannot see the My Computer icon click Start (menu), then point to
Computer. Right-click it to make the sub-menu appear and scroll down to P
3).

3.Click the Hardware (tab), then click Device Manager (button). 
4.Click “+” next to Other Devices (if its sub-items are not shown).
5.Right-click Universal Serial Bus (USB) Controller and select Uninstall >
6.Restart the computer and it will find the USB 2.0 controller.
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Control Panel in the Windows OS
k the Add/Remove Programs
the individual driver listed (if not
nstall it, following the on screen
be necessary to restart the comput-
propriate section of the manual to
pdate/reinstall procedure for the
n.

ot listed in the Add/Remove Pro-

menu), point to Settings and click 
el (or click Control Panel). 
 System (icon); System (icon) is in 
e and Maintenance (category).
are (tab) > Device Manager 

 the device you wish to update/
driver for (you may need to click 

Update Driver button (check the 
nd follow the on screen prompts.
Authorized Driver Message
If you receive a message telling you that the driver
you are installing is not authorized (Digital Signa-
ture Not Found), just click Yes or Continue Any-
way to ignore the message and continue the
installation procedure.

You will receive this message in cases where the
driver has been released after the version of Win-
dows you are currently using. All the drivers pro-
vided will have already received certification for
Windows.

Version Conflict Message
During driver installation if you encounter any “file
version conflict” message, please click Yes to
choose to keep the existing (newer) version.

Updating/Reinstalling Individual 
Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To

do this go to the 
and double-clic
item. If you see 
see below), uni
prompts (it may 
er). Go to the ap
complete the u
driver in questio

If the driver is n
grams item:

1. Click Start (
Control Pan

2. Double-click
Performanc

3. Click Hardw
(button).

4. Double-click
reinstall the 
“+”).

5. Look for the 
Driver tab) a
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iver installation order from Table 4 - 
 - 7 (the drivers must be installed 
r) which is the same as that listed in 
low.
ct the driver you wish to install, after 
h driver it will become greyed out (if 

reinstall any driver, click the Unlock 

structions of each individual driver 
ed in the following pages.

 - Drivers Installer Screen 2
- 6 Driver Installation

Driver Installation
Insert the Device Drivers & Utilities + User’s Man-
ual CD-ROM and click the Install WinXP Driv-
ers OR Install Win2K Drivers button (only the
button appropriate for your OS will be highlighted).
Alternatively you can browse to the CD and select
the appropriate driver folder, then run the auto-
run.exe file.

Figure 4 - 2 - Drivers Installer Screen 1

1. Check the dr
1 on page 4
in this orde
the menu be

2. Click to sele
installing eac
you need to 
button).

3. Follow the in
install as list

Figure 4 - 3
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4

llation Procedure
ers driver and utility installation in-
ndows 2000 Professional and Win-
& Professional.

re Found
essage “New Hardware Found”
ardware Wizard) during the in-
ure (other than when outlined in
 procedure), click Cancel to close
 follow the installation procedure

k Installation
nstall the appropriate service pack
ing system before installing any
indows 2000 Service Pack 4” on
Windows XP Service Pack 2” on
Driver Insta
This section cov
structions for Wi
dows XP Home 

New Hardwa
If you see the m
(Found New H
stallation proced
the driver install
the window, and
as directed.

Service Pac
Make sure you i
for your operat
drivers (see “W
page 4 - 3 and “
page 4 - 4).

Driver Windows 2000 (SP4) or 
Windows XP (SP2)

Audio page 4 - 8

Video page 4 - 8

Network (LAN) page 4 - 8

Modem page 4 - 9

TouchPad page 4 - 9

HK Buttons page 4 - 10

Auto Mail Checker page 4 - 10

802.11g Wireless 
LAN

See page 7 - 3

Bluetooth See pages 7 - 6 & 7 - 8

PC Camera See page 7 - 11

Table 4 - 1 - Driver Installation Order
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0/WinXP)
ll Lan Driver > Yes from the 

ller menu. 

menu) > Run... and navigate 
 D:\Drivers\LAN\setup.exe and 

 Finish.
to restart the computer.
settings can now be configured.
- 8 Driver Installation

Audio (Win2000/WinXP)
1. Click 1. Install Audio Driver > Yes from the 

Drivers Installer menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Drivers\Audio\Setup.exe and 
click OK.

2. Click Next > Finish to restart the computer.
3. You can click the AC97 Audio Configuration 

icon  in the taskbar for configuration options.

Video (Win2000/WinXP)
1. Click 2. Install Video Driver > Yes from the 

Drivers Installer menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Drivers\Video\setup.exe and 
click OK.

2. Click Next > Next > Next > Next.
3. If you wish to view the Readme file select Yes 

and click Next, otherwise select No and click 
Next.

4. Click Finish to restart the computer.

LAN (Win200
1. Click 3. Insta

Drivers Insta
OR 
Click Start (
(Browse..) to
click OK.

2. Click Next >
3. Click Finish 
4. The network 
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in2000/WinXP)
ll TouchPad Driver > Yes from 
staller menu. 

menu) > Run...  (go to step 2) and 
wse...) to D:\Drivers\Touch-

or WinXP\SETUP.EXE and click 

 Next.
 view the Readme file select Yes 
t, otherwise select No and click 

to restart your computer.
 configure your TouchPad as 
ouchPad and Buttons/Mouse” 

8.
Modem (Win2000/WInXP)
1. Click 4. Install Modem Driver > Yes from the 

Drivers Installer menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Drivers\Modem\Win2K or 
WinXP\Setup.exe and click OK.

2. Click  (button).
3. Click  (button).
4. The modem is ready for dial-up configuration.

TouchPad (W
1. Click 5. Insta

the Drivers In
OR 
Click Start (
navigate (Bro
pad\Win2K 
OK.

2. Click Next >
3. If you wish to

and click Nex
Next.

4. Click Finish 
5. You may then

outlined in “T
on page 2 - 1

Modem Country Selection

Be sure to check if the modem country selection is ap-
propriate for you (Control Panel > Phone and Mo-
dem Options).
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 (Win2000/WinXP)
ocedure in “802.11g WLAN Driv-
WinXP/Win2K)” on page 7 - 3.

in2000/WinXP)
dure in “Bluetooth Driver Instal-

0)” on page 7 - 6 or “Bluetooth
ion (WinXP)” on page 7 - 8.

Win2000/WinXP)
edure in “PC Camera Driver In-
000/WinXP)” on page 7 - 11.
- 10 Driver Installation

HK Buttons (Win2000/WinXP)
1. Click 6. Install HotKey Driver > Yes from the 

Drivers Installer menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Drivers\Hotkey\Setup.exe 
and click OK.

2. Choose the language you prefer and click OK.  
3. Click Next > Finish to restart your computer.
4. The program will run upon startup.
5. For further details see “HK Buttons” on page 2 

- 15.

Auto Mail Checker (Win2000/WinXP)
1. Click Start (menu) > Run... and navigate 

(Browse..) to D:\Drivers\AUTO-
MAIL\SETUP.EXE and click OK. 

2. To continue click Next > Next > Finish.
3. For further details see “Auto Mail Checker” on 

page 2 - 7.

Wireless LAN
See the install pr
er Installation (

Bluetooth (W
See install proce
lation (Win200
Driver Installat

PC Camera (
See install proc
stallation (Win2



BIOS Utilities

Overview 5 - 1

5

are: 

hanges
er first
r, keep
mation

f what
anging
ts, con-

BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to
Setup and restore the
Setup Defaults with
<F9>.
Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in softw

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
If your computer has never been set up, or you are making important c
to the system (e.g. hard disk setup), then you should review this chapt
and note the original settings found in Setup. Even if you are a beginne
a record of the settings you find and any changes you make. This infor
could be useful if your system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure o
you are doing. Many of the settings are required by the system, and ch
them could cause it to become unstable or worse. If you have any doub
sult your service representative.
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 (POST)
ystem takes a few seconds to con-
 on-board RAM (memory).

tell you if there is anything wrong.
tem from booting, it will display a
tup. 

 will disappear and the system will
, you can’t get into Setup without

.

1.40GHz

1

- 2 The Power-On Self Test (POST)

The Power-On Self Test
Each time you turn on the computer, the s
duct a POST, including a quick test of the

As the POST proceeds, the computer will 
If there is a problem that prevents the sys
system summary and prompt you to run Se

If there are no problems, the Setup prompt
load the operating system. Once that starts
rebooting.

POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.Enter Setup prompt

appears only during
POST

Note: The POST
screen as pictured is
for guideline purposes
only. The POST
screen on your compu-
ter may appear slightly
different. If you choose
the QuickBoot Mode
option this screen will
appear briefly.

Figure 5 - 1
POST Screen

Phoenix cME FirstBIOS Notebook Pro
Copyright 1985-2003 Phoenix Technologies Ltd
All Rights Reserved

Build Time: 12/17/04 17:30:43
SiS661MX A1(FirstBIOS)

M3 Series-R1.00.D8C
KBC Ver:1.00.D1

CPU = Intel(R) Celeron(R) M processor
639K System RAM Passed
989M Extended RAM Passed
1024K Cache SRAM Passed
System BIOS shadowed
Fixed Disk 0: TOSHIBA MK3018GAP
ATAPI CD-ROM: QSI DVD-ROM SDR-083
Mouse intialized

Press <F2> to enter SETUP

2
3

4
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The Po

Failing the POST
Errors can be detected during the POST. There are two categories, “fat
“non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something se
wrong with your system. Take the computer to your service representa
authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message iden
the problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup 

Press F1 to see if the boot process can continue. It may work, without t
rect configuration. 

Press F2 to run the Setup program and try to correct the problem. If y
get an error message after you change the setting, or if the “cure” seem
worse, call for help.
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m how to configure itself and man-
rt configuration).

 press F2 during the POST. The
igure 5 - 1 is usually present for a

f you get a “Keyboard Error”, (usu-
ust press F2 again.

 the Ctrl + Alt + Delete combina-
ed. The Setup main menu will ap-
- 4 The Setup Program

The Setup Program
The Phoenix Setup program tells the syste
age basic features and subsystems (e.g. po

Entering Setup
To enter Setup, turn on the computer and
prompt (Press F2 to Enter Setup) seen in F
few seconds after you turn on the system. I
ally because you pressed F2 too quickly) j

If the computer is already on, reboot using
tion and then hold down F2 when prompt
pear.
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hlight-
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Setup Menus

The Setup menus
shown in this section
are for reference only.
Your computer’s men-
us will indicate the con-
figuration appropriate
for your model and op-
tions.
Setup Screens
The following pages contain additional advice on portions of the Setu

Along the top of the screen is a menu bar with five (5) menu headings
you select a heading, a new screen appears. Scroll through the feature
on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bo
the screen. If these tools are confusing, press F1 to call up a Genera
screen, then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the hig
ed item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu 
subject. The sub-menu screen that appears has a similar layout, but the
key may execute a command.
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i.e., ØØ = midnight; 13 = 1 pm). If
in your operating system, you will
ons may also alter data files to re-

tility

Exit

hange Values F9 Setup Defaults
elect �Sub-Menu F10 Save and Exit

Item Specific Help

<Tab>, <Shift Tab>, or
<Enter> selects field.

P- (PM)]
083- (PM)]
- 6 Main Menu

Main Menu

System Time & Date
The hour setting uses the 24-hour system (
you can change the date and time settings 
also change these settings. Some applicati
flect these changes.

Figure 5 - 2
Main Menu

PhoenixBIOS Setup U

Main Advanced Security Boot

F1 Help �� Select Item -/+ C
Esc Exit �� Select Menu Enter S

System Time: [22:11:05]
System Date: [09/22/2004]

Legacy Diskette A: [Disabled]
�Primary Master  [Toshiba MK3018GA
�Secondary Master [QSI DVD-ROM SDR

QuickBoot Mode: [Enabled]
Floppy Check [Disabled]

System Memory 640 KB
Extended Memory 989 KB

Main

13
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Legacy Diskette A:
This control allows you to enable/reconfigure the floppy disk drive.

Primary Master
Pressing Enter opens the sub-menu to show the configuration of the HD
fits in the computers HDD bay. These items are configured automatica
you.

Secondary Master
Pressing Enter opens the sub-menu to show the configuration of the C
vice. These items are configured automatically for you.

QuickBoot Mode:
Enable this option to eliminate the memory test and other delays at pow

Floppy Check:
Enabling this will verify floppy type on boot. Boot process will be fast
this disabled.

System/Extended Memory:
This item contains information on the system memory, and is not user 
urable. The system will auto detect the amount of memory installed.
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information on your system includ-

etup Utility

ower Boot Exit

hange Values F9 Setup Defaults
elect �Sub-Menu F10 Save and Exit

Item Specific Help

]

Display Chipset
Information if you
need it.
- 8 Advanced Menu

Advanced Menu

Chipset Information (Advanced Menu)
Pressing Enter here will provide valuable 
ing CPU type and speed etc.

Figure 5 - 3
Advanced Menu

PhoenixBIOS S

Main Advanced Security P

F1 Help �� Select Item -/+ C
Esc Exit �� Select Menu Enter S

Setup Warning
Setting items on this menu to incorrect
values may cause your system to malfunction.

�Chipset Information

Select Keyboard Language [English]
Intel On-Screen Branding Logo: [Disabled]
USB Host Controller: [Enabled]
USB BIOS Legacy Support: [Enabled]

USB 2.0 Host: [Enabled]

PS/2 Mouse [Auto Detect
Large Disk Access Mode [DOS]
Installed O/S: [WINXP]
Local Bus IDE adapter: [Both]

Embedded MAC Device [Enabled]

Embedded Modem Device [Enabled]

Embedded Audio Device [Enabled]

Reset Configuration Data: [No]

Secured Setup Configurations [No]

Advanced
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 Select
Select K/B Language (Advanced Menu)
Allows you to choose between English or Japanese keyboard language
Intel On-Screen Branding Logo (Advanced Menu)
Enables or disables the Intel startup splash screen.

USB Host Controller (Advanced Menu)
This item enables or disables USB hardware support.

USB BIOS Legacy Support (Advanced Menu)
Choose “Enabled” if you intend to use USB devices in systems which
normally support USB functionality (e.g. DOS). The default setting i
abled” and does not need to be changed if you intend to use your USB d
in Windows.

USB 2.0 Host (Advanced Menu)
Enables or disables SiS embedded USB 2.0 (EHCI) Host.

PS/2 Mouse (Advanced Menu)
Configure the PS/2 mouse port here.

Large Disk Access Mode (Advanced Menu)
Select “Other” if you are using systems such as Novell, UNIX etc.
“DOS” (default) if you are using Windows.
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g system you’re using. The default

)
pport for the local bus IDE adapter
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Advanced Menu)
rk, modem and audio devices from

nu)
hange the setting to Yes if you have
red the system, resulting in such a

ystem is unable to boot.

 Menu)
g and Play Operating system from
- 10 Advanced Menu

Installed OS (Advanced Menu)
This item tells the computer what operatin
setting is WinXP.

Local Bus IDE adapter (Advanced Menu
This item allows you to enable or disable su
(the interface for the hard disk and CD dev

Embedded MAC/Modem/Audio Device (
Enable or Disable the SiS Embedded netwo
these menu items.

Reset Configuration Data (Advanced Me
This item is set to No as default. You can c
installed a new add-on which has reconfigu
serious system conflict that the operating s

Secured Setup Configuration (Advanced
Choosing “Yes” in this item prevents a Plu
changing system settings.
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Password Warning

If you choose to set a
boot password, NEV-
ER forget your pass-
word.

The consequences of
this could be serious. If
you cannot remember
your boot password
you must contact your
vendor and you may
lose all of the informa-
tion on your hard disk.

Figure 5 - 4
Security Menu

ults
xit

elp

d
the
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Setup utility. This will not aff
cess to the computer OS (only the Setup utility). 

Set User Password (Security Menu)
Entering a user password will control access to the system at boot.

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defa
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and E

Item Specific H

Supervisor Passwor
controls access to
setup utility.

Security

Supervisor Password Is: Clear
User Password Is: Clear

Set Supervisor Password [EEnter]
Set User Password [Disabled]
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 for an operating system (e.g. Win-
nu, and in this priority order. If it
evice, it will try to load it from the
ot Menu. 

tility

oot Exit

ange Values F9 Setup Defaults
lect �Sub-Menu F10 Save and Exit

Item Specific Help

Keys used to view or
configure devices:
<Enter> expands or
collapses devices with
a + or -
<Ctrl+Enter> expands
all
<Shift+1> enables or
disables a device.
<+> and <-> moves the
device up or down.
<n> May move removable
device between the Hard
Disk or Removable Disk
<d> Remove a device
that is not installed.

oot
- 12 Boot Menu

Boot Menu

When you turn the computer on it will look
dowsXP) from the devices listed in this me
cannot find the operating system on that d
next device in the order specified in the Bo

Figure 5 - 5
Boot Menu

PhoenixBIOS Setup U

Main Advanced Security B

F1 Help �� Select Item -/+ Ch
Esc Exit �� Select Menu Enter Se

Removable Devices
CD-ROM Drive
+Hard Drive
Network Boot

B
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t order.
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-ROM/
Boot devices usually are hard drives, floppy drives, CD-ROMs and
(Local Area Networks).

When you specify a device as a boot device on the Boot Menu, it requ
availability of an operating system on that device. Most home com
come with an operating system already installed on “Drive C:”.

If you wish to boot from a CD-ROM you will need to add it to the boo
As a general rule the order below is recommended:

1. Removable Devices (usually floppy disks)
2. CD-ROM/DVD-ROM Drive
3. Hard Drive
4. Network Boot

In everyday use you will usually boot from the hard drive, however the
be occasions when it is advantageous to boot from a floppy disk or CD
DVD-ROM.
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iscarding Changes, will wipe out
You can also choose to restore the
etup to its original state, and erase

previous session.

Utility

Exit

ange Values F9 Setup Defaults
lect �Sub-Menu F10 Save and Exit

Item Specific Help

Exit System Setup and
save your changes to
CMOS.

Exit
- 14 Exit Menu

Exit Menu

Choosing to Discard Changes, or Exit D
any changes you have made to the Setup. 
original Setup defaults that will return the S
any previous changes you have made in a 

Figure 5 - 6
Exit Menu

PhoenixBIOS Setup

Main Advanced Security Boot

F1 Help �� Select Item -/+ Ch
Esc Exit �� Select Menu Enter Se

Exit Saving Changes
Exit Discarding Changes
Load Setup Defaults
Discard Changes
Save Changes
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Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Chapter 6: Upgrading The Com
Overview
This chapter contains information on upgrading the computer. Foll
steps outlined to make the desired upgrades. If you have any trouble o
lems you can contact your service representative for further help. Befo
begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear a
static wrist strap to ground yourself because static electricity may dam
components.

The chapter includes:

• Removing the Battery
• Upgrading the HDD
• Upgrading the System Memory
• Upgrading the Optical Device
Please make sure that you review each procedure before you perfo
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tem’s case, adding and sometimes
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 a service contract
ment 

r service representative to purchase
- 2 Overview

When Not to Upgrade
These procedures involve opening the sys
replacing parts.

You should not perform any of these upgr

• Your system is still under warranty or
• You don’t have all the necessary equip
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact you
or replace the component(s).

Power Safety 
Warning

Before you undertake any
upgrade procedures,
make sure that you have
turned off the power, and
disconnected all peripher-
als and cables (including
telephone lines). It is ad-
visable to also remove
your battery in order to
prevent accidentally turn-
ing the machine on.
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 safety

lock 

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 1
Battery Removal
Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for
reasons it is best to remove the battery.

1. Turn the computer off, and turn it over.
2. Locate the battery bay at point .
3. Slide the battery lock  in the direction of the arrow (towards the un

symbol ), and hold it in place.
4. Slide the battery  out of the computer’s battery bay.

1
2

3

1

2

3
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k Drive
mmodate other 2.5" IDE hard disk
rage on pages  A - 3) Follow your
s, and install all necessary drivers
ll” on page 4 - 1), when setting up

nd remove the battery.
 disk cover, and remove the cover 
 disk removal is pictured. Model B 
DD & RAM modules).

3

- 4 Upgrading the Hard Disk Drive

Upgrading the Hard Dis
The hard disk drive can be taken out to acco
drives with a height of 9.5mm (h) (see Sto
operating system’s installation instruction
and utilities (as outlined in “What to Insta
a new hard disk.

1. Turn off the computer, and turn it over a
2. Remove screws  &  from the hard

 (Note: Only Model A computer hard
computers have a single cover for the H

HDD System 
Warning

New HDD’s are blank.
Before you begin make
sure:
You have backed up any
data you want to keep
from your old HDD.
You have all the CD-
ROMs and FDDs re-
quired to install your oper-
ating system and
programs.
If you have access to the
internet, download the lat-
est application and hard-
ware driver updates for
the operating system you
plan to install. Copy these
to a removable medium.

Figure 6 - 2
HDD Cover Removal

1 2
3

1

2
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arrow 

e hard 

Figure 6 - 3
HDD Assembly 

Removal
Upgra

3. Pull the tab  to slide the hard disk assembly in the direction of the 
.

4. Lift the hard disk assembly  up out off the computer.
5. Remove screws  - , and separate the hard disk cover  from th

disk .
6. Reverse the process to install a new hard disk.

1
2

3
4 7 8

9

1

3

2
4

5

7

6

8

9
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emory (RAM)
 200pin Small Outline Dual In-line
y on page A - 3). The total memory
routine once you turn on your com-

nd remove the battery.
ry socket cover , and remove the 
AM removal is pictured. Model B 
DD & RAM modules).

7

7

- 6 Upgrading the System Memory (RAM)

Upgrading the System M
The computer has two memory sockets for
(SO-DIMM) memory modules (see Memor
size is automatically detected by the POST 
puter. 

1. Turn off the computer, and turn it over a
2. Remove screws  -  from the memo

cover (Note: Only Model A computer R
computers have a single cover for the H

Figure 6 - 4
Memory Socket Cover 

Removal

1 6

1 2 3

456
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Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

Figure 6 - 5
Removing/

Installing a RAM 
Module
Upgrading the

3. Gently pull the two release latches (  &  in Figure 6 - 5) on the s
the memory socket in the directions of the arrows.

4. The module  will pop-up, and you can remove it.
5. Pull the latches to release the second module if necessary.
6. Insert a new module holding it at about a 30° angle and fit the conne

firmly into the memory slot.
7. The module’s pin alignment will allow it to only fit one way. Make sure

module is seated as far into the slot as it will go. DO NOT FORCE th
module; it should fit without much pressure.

8. Press the module in and down towards the mainboard until the slot le
click into place to secure the module.

9. Replace the memory socket cover and 6 screws (see Figure 6 - 4).
10. Restart the computer, and the BIOS will register the new memory 

configuration as it starts up.

1 2

1

3

2

3
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2

4

2

3

4

- 8 Upgrading the Optical Device

Upgrading the Optical D
1. Turn off the computer, and turn it over a
2. Remove screw  from the optical devi

cover.
3. Apply pressure at point  to push the o

computer.
4. Reverse the process to install the new d

Figure 6 - 6
Optical Device 

Removal Procedure

1

3

1
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Warranty

The CPU is not a user
serviceable part. Opening
this compartment, or ac-
cessing the CPU in any
way, may violate your
warranty.

Unauthorized tampering
with the HDD may also vi-
olate your warranty.
U

Upgrading the Processor
If you want to upgrade your computer by replacing the existing process
a faster/new one you will need to contact your customer service repr
tive. We recommend that you do not do this yourself, since if it is done
rectly you may damage the processor or mainboard.
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Chapter 7: Wireless, Bluetooth 
Modules
Overview
This chapter contains the information on the optional WLAN, Blu
and PC Camera modules which may come with your computer, dep
on the configuration purchased. If you are unsure please contact yo
vice representative.

The chapter includes information on the following:

• 802.11g Wireless LAN Module 
• The Bluetooth Module
• The PC Camera Module
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odule
upplied as an option for your com-
ter” on page 1 - 4).

r, make sure that the Wireless LAN
. Use the Module ON/OFF Button
 - 13) to toggle power to the Wire-
he drivers in the order indicated
- 2 Mini-PCI Wireless LAN Module

Mini-PCI Wireless LAN M
A 802.11g Mini-PCI WLAN module is s
puter (see “Getting to Know Your Compu

Before installing the 802.11g WLAN drive
module is on (the  LED will be green)
(see “Module ON/OFF Button” on page 1
less LAN module (make sure you install t
in Table 4 - 1 on page 4 - 7).

Wireless Device 
Operation Aboard 

Aircraft

The use of any porta-
ble electronic trans-
mission devices
aboard aircraft is usu-
ally prohibited. Make
sure the module(s) are
OFF if you are using
the computer aboard
aircraft. When your
computer ‘Boots Up’
the modules will be
OFF. 
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Network Connection

Use the Windows
Network Connec-
tions control panel to
access available wire-
less networks (Start >
Settings > Network
Connections / Net-
work and Dial-up
Connections or Start
> Connect To > Show
all Connections).

See “Changing the
Control Setting in
WinXP” on page 7 - 4

Figure 7 - 1
INPROCOMM 
WLAN Utility
Mini-PC

802.11g WLAN Driver Installation (WinXP/Win2K)
1. Turn the WLAN module on (if the Found New Hardware Wizard 

appears, click Cancel).
2. Insert the Wireless LAN CD-ROM into the CD drive.
3. The program will run automatically.
4. Click Install Software (button).
5. Click Next.
6. Click the button to accept the license agreement, then click Next.
7. Click Install >Finish > Exit.
8. Access any available wireless networks from the icon in the taskb

(Win2000), or from Network Connections (WinXP) control pan
Windows (see sidebar).

The INPROCOMM Wireless LAN Configuration Utility may be ru
the Start menu (Start > Programs/All Programs > Wlan > WLAN C
uration Utility), and may then be accessed from the icon  in the tas
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P 
 for wireless LAN control in Win

 use the INPROCOMM Wireless
ur WLAN connection. Check the
o this.

kbar and click Open Network Con-

onnection and then click “Change 
lick it and scroll to select 

se Windows to configure my 
OK.
skbar to begin using the 
ation Utility to control the WLAN 
- 4 Mini-PCI Wireless LAN Module

Changing the Control Setting in WinX
The operating system is the default setting
XP. It is recommended that you switch to
LAN Configuration Utility to control yo
User’s Manual for instructions on how to d

1. Right-click the WLAN icon  in the tas
nections.

2. Click to select the Wireless Network C
Settings of this connection” (or right-c
properties).

3. Click Wireless Networks (tab).
4. Click to remove the tick in the tickbox “U

wireless network settings”, then click 
5. Double-click the WLAN icon  in the ta

INPROCOMM Wireless LAN Configur
connection.



Wireless, Bluetooth & PC Camera Modules

I Wireless LAN Module 7 - 5

7

Figure 7 - 2
Switching WLAN 
Controls (WinXP)
Mini-PC
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e sure that the optional Bluetooth
. Use the Module ON/OFF Button
 - 13) to toggle power to the Blue-

re Wizard appears, click Cancel).
 order indicated in Table 4 - 1 on

2000)
ound New Hardware Wizard 

e CD drive.

n Software and click Next.
greement, then click Next.
d if you want to continue).
uter.

 button to turn the module on.
luetooth Configuration control 
s and click Control Panel then 
tion icon).
s on the Bluetooth CD-ROM in 
oth CD-ROM and click Browse 
stall the program to read the file.
- 6 Bluetooth Module

Bluetooth Module
Before installing the Bluetooth driver, mak
module is on (the  LED will be green)
(see “Module ON/OFF Button” on page 1
tooth module (if the Found New Hardwa
Make sure you install the drivers in the
page 4 - 7.

Bluetooth Driver Installation (Win
1. Turn the Bluetooth module on (if the F

appears, click Cancel).
2. Insert the Bluetooth CD-ROM into th
3. The program will run automatically.
4. Click Install Drivers and Applicatio
5. Click the button to accept the license a
6. Click Next > Install (click OK if aske
7. Click Finish > Yes to restart the comp
8. After the computer restarts, press the 
9. You can configure the settings in the B

panel (Start menu and point to Setting
double-click the Bluetooth Configura

10. The Bluetooth Manual (readme.pdf) i
the Userguide folder (insert the Blueto
this CD). Click Acrobat Reader to in

Wireless Device 
Operation Aboard 

Aircraft

The use of any porta-
ble electronic trans-
mission devices
aboard aircraft is usu-
ally prohibited. Make
sure the module(s) are
OFF if you are using
the computer aboard
aircraft. When your
computer ‘Boots Up’
the modules will be
OFF. 
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er hear
en fol-

int to 
ultime-

tek 

e 
Bluetooth Driver Audio Setup (Win2000)
After installing the Bluetooth driver in Windows 2000 you may no long
any sound, nor see the Volume icon in the taskbar. If this is the case th
low this procedure:

1. Go to the Sounds & Multimedia Control Panel (Start Menu and po
Settings and click Control Panel then double-click the Sounds & M
dia icon).

2. Click the Audio tab.
3. In the Sound Playback and Sound Recording menus choose Real

AC97 Audio.
4. Click the Sounds tab and make sure that the tickbox to “Show volum

control on the taskbar” is ticked.
5. Click OK.



Wireless, Bluetooth & PC Camera Modules

7

7

XP)
ound New Hardware Wizard 

e CD drive.

n Software and click Next.
greement, then click Next.
K/Continue Anyway if asked if 

ld be open (if the window is not 
2” on page 4 - 4 for instructions); 
he Hardware (tab). 
f its sub-items are not shown).
 and select Update Driver.
ext.
pears, click “Install from a list 

n click Next.
e driver to install.” > Next.
oth Device, and click Next.
ws.
luetooth Configuration control 

gs and click Control Panel then 
tion icon).

is on the Bluetooth CD-ROM in 
oth CD-ROM  and click Browse 
stall the program to read the file.
- 8 Bluetooth Module

Bluetooth Driver Installation (Win
1. Turn the Bluetooth module on (if the F

appears, click Cancel).
2. Insert the Bluetooth CD-ROM into th
3. The program will run automatically.
4. Click Install Drivers and Applicatio
5. Click the button to accept the license a
6. Click Next > Install > Finish (click O

you want to continue).
7. The System Properties window shou

open see “Windows XP Service Pack 
click Device Manager (button) from t

8. Click “+” next to Bluetooth Radios (i
9. Right-click Generic Bluetooth Radio
10. Select “No, not this time” and click N
11. When the Hardware Update Wizard ap

or specific location (Advanced)” the
12. Click “don’t search. I will choose th
13. Click to select Billionton USB Blueto
14. Click Finish and close the open windo
15. You can configure the settings in the B

panel (Start menu and point to Settin
double-click the Bluetooth Configura

16. The Bluetooth Manual (readme.pdf) 
the Userguide folder (insert the Blueto
this CD). Click Acrobat Reader to in

Bluetooth Support in 
Windows XP Service 

Pack 2

Windows XP Service
Pack 2 includes sup-
port for Bluetooth de-
vices, once the device
is enabled.

By installing the driver
you will get additional
application support for
your Bluetooth device.
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e Blue-

el) and 
/

k 

cces-

nnect 

el) and 
Cate-

k 56K 
Bluetooth Control Panel Options
You may need to change some control panel options after installing th
tooth driver:

Audio
1. Go to the Start menu and point to Settings (or just click Control Pan

click Control Panel, then double-click the Sounds & Audio Devices
Sounds & Multimedia icon (Category View > Speech, and Audio 
Devices).

2. Click Audio (tab) and make sure that the “Default device:” is Realte
AC97 Audio.

Hyper Terminal
1. Go to Start menu and click Programs/All Programs, then point to A

sories > Communications > HyperTerminal.
2. Double-Click your connection, and make sure you have selected “Co

Using:” Smart Link 56K Modem.

FAX (WinXP)
1. Go to the Start menu and point to Settings (or just click Control Pan

click Control Panel, then double-click the Printers and Faxes icon (
gory View > Printers and Other Hardware).

2. Double-click your fax icon to bring up the Fax Console.
3. Click the Tools menu and scroll down to “Configure Fax...”.
4. Click Next > Next and make sure that the fax device is the Smart Lin

Voice Modem.
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gs and click Control Panel, then 

k the Open Fax Service 

e left.
right window, with the device with 

m and use the arrows to move it to 
 windows.
- 10 Bluetooth Module

FAX (Win2000)
1. Go to the Start menu and point to Settin

double-click the Fax icon.
2. Click Advanced Options (tab) and clic

Management Console (button).
3. Click Devices in the Tree window on th
4. The fax devices will be displayed in the 

the highest priority displayed at the top.
5. Select the Smart Link 56K Voice Mode

the top of the priority list, then close the
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the de-
 install
e Mod-
 toggle

on-

e on. 

e 

Taking Still Pictures

You may take still pic-
tures in the Windows
XP operating system
only.

Double-click the My
Computer icon on the
desktop, or go the
Start menu and point
to My Computer, then
click it.

.Double-click the CMM
PC Camera icon.

 

Click Take a new pic-
ture in the Camera
Tasks box.

t up-
tion
PC Camera
If you have purchased the optional PC Camera you will need to install 
vice driver for it as indicated on the following pages (make sure you
the drivers in the order indicated in Table 4 - 1 on page 4 - 7). Use th
ule ON/OFF Button (see “Module ON/OFF Button” on page 1 - 13) to
power to the PC Camera module.

PC Camera Driver Installation (Win2000/WinXP)
1. Insert the PC Camera CD-ROM into the drive.
2. Click Next (click Yes/Continue Anyway if asked if you want to c

tinue at any time).
3. Click Finish to restart the computer.
4. After the computer restarts, press the  button to turn the modul

(the computer will find and install the new hardware for you).
5. Run the AMCAP program from the CMM PC Camera item in th

Start > Programs/All Programs menu.

Latest PC Camera Driver Information

Check the PC Camera CD, and any accompanying insert pages, for the lates
dated information on the PC Camera driver, which may override the informa
provided here.
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our camera, it is necessary to setup

gs (or just click Control Panel) and 
e Sounds & Audio Devices icon 

Devices).
tab.
oll down and click Properties.
d click Microphone (check box), 

 Recording Control panel, under 
ost the volume as high as it will go).

gs and click Control Panel then 
ia icon.
ton) in the Sound Recording menu.
tions menu.
 Microphone section is checked, 
o.
- 12 PC Camera

PC Camera Audio Setup
If you wish to capture video & audio with y
the audio recording options in Windows.

(WinXP)
1. Go to the Start menu and point to Settin

click Control Panel, then double-click th
(Category View > Speech, and Audio 

2. Click Advanced in the Device volume 
3. Click Options (Volume Control) and scr
4. Click Recording (Adjust volume for) an

then click OK.
5. Make sure the Select (check box) in the

the Microphone section, is checked (bo
6. Close the open windows.

(Win2000)
1. Go to the Start menu and point to Settin

double-click the Sounds and Multimed
2. Click Audio (tab) and click Volume (but
3. Select Advanced Controls from the Op
4. Make sure the Select (check box) in the

and boost the volume as high as it will g
5. Close the windows.
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Figure 7 - 3
Audio Setup 

(Windows XP)
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al purpose video viewing and test-
at.

 > Programs/All Programs > CMM 
that you set the capture file before 
File below).
 wish to capture audio make sure 

) and select Start Capture.
ve not set the captured file) you will 
 (see the sidebar - Pre-Allocating 
tart Capture again.
d press Esc to stop the capture.
enu and select Save Captured 
tion, then click Open (you can view 

er).

d to set the capture file name on the
 program the next time the file will
ly captured file. To avoid overwrit-
e.. option in the File menu, and set
et the name and location then click
e file size if prompted).
- 14 PC Camera

AMCAP
AMCAP is a video viewer useful for gener
ing, and can capture video files to .avi form
 

1. Run the AMCAP program from the Start
PC Camera  menu (it is recommended 
the capture process - see Set Capture 

2. Go to the Capture menu heading (if you
that the Capture Audio option is ticked

3. On the first run of the program (if you ha
be asked to choose a file name and size
File Space) for the captured file. Click S

4. Click OK to start capturing the video, an
5. If you wish to, you may go to the File m

Video As..., choose a file name and loca
the file using the Windows Media Play

Set Capture File
In AMCAP program you will only be aske
first run of the program. When you run the
automatically be overwritten with the new
ing files you can go to the Set Capture Fil
the file name and location before capture. S
Open (you can choose Cancel to ignore th

Pre-Allocating File 
Space

You may pre-allocate
the file size for the cap-
ture file in the AMCAP
program. You can
choose to ignore this
by clicking Cancel.

Pre-allocating space
on the hard disk can
improve the capture
quality (particularly of
large capture files), by
reducing the amount of
work the hard disk has
to do in finding space
for the video data as it
is being captured.

You may find it helpful
to defragment the HDD
before capture.
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ou can

 CMM 

Figure 7 - 4
Camera Controls
Eliminating Screen Flicker
If you find that the video screen in the AMCAP program is flickering, y
try to adjust the option from the Video Capture Filter options.
1. Run the AMCAP program from the Start > Programs/All Programs >

PC Camera menu.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. You can choose either 50Hz or 60Hz from the No Flicker box.
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Troubleshooting

Overview 8 - 1

8

g your service representative, you
mmon problems and their possible
ere before you panic. If you don’t
uctions carefully and observed the
resentative. You should also make

nient time possible, so you should
he system still won’t cooperate, try
nsaved data, but it may start work-
Chapter 8: Troubleshooting
Overview
Should you have any problems with your computer, before consultin
may want to try to solve the problem yourself. This chapter lists some co
solutions. This can’t anticipate every problem, but you should check h
find the answer in these pages, make sure you have followed the instr
safety precautions in the preface. If all else fails, talk to your service rep
a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconve
preview this section just in case. If, after you’ve tried everything, and t
turning it off for a few minutes and then rebooting. You will lose any u
ing again. Then call your service representative.
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8

 to a problem when your computer

al outlet? If plugged into a 
ower Indicators (see “LED 
computer’s power status.

o loose connections anywhere.

r Standby mode by pressing the 
e “Conserving Power (System)” 
 wake-up the system.

Fn + F9 and F10 keys to adjust 

et to “external only” display (see 

f you have one connected) when 
e “Invalid system disk - Replace 
ia. Press any key to restart”).
- 2 Basic Hints and Tips

Basic Hints and Tips
Many of the following may seem obvious but they are often the solution
appears not to be working. 

• Power - Is the computer actually plugged into a working electric
power strip, make sure it is actually working. Check the LED P
Power & Communication Indicators” on page 2 - 6) to see the 

• Connections - Check all the cables to make sure that there are n

• Power Savings - Make sure that the system is not in Hibernate o
keys configured in your Power Management/Power Options (se
on page 3 - 17), or by pressing the Fn + Esc key combination, to

• Brightness - Check the brightness of the screen by pressing the 
the brightness (see “Advanced Video Controls” on page 3 - 2).

• Display Choice - Press Fn + F6 to make sure the system is not s
“Switching/Enabling Displays (Keyboard)” on page 3 - 8).

• Boot Drive - Make sure there are no floppy disks in the drive (i
you start up your machine (this is a common cause of the messag
the disk, and then press any key” / “Remove disks or other med
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8

 and programs safe, but close to 
them out of their original cases, 

 as you can. You may schedule 
puter. You can use those that are 
 programs to do so.

r computer). This is especially 
(see “Security Menu” on page 5 

s, mail settings etc. (even if just 

ing the CPU in any way, may violate
Backup an

Backup and General Maintenance
• Always backup your important data, and keep copies of your OS

hand. Don’t forget to note the serial numbers if you are storing 
e.g. in a CD wallet.

• Run maintenance programs on your hard disk and OS as often
these programs to run at times when you are not using your com
provided free with your OS, or buy the more powerful dedicated

• Write down your passwords and keep them safe (away from you
important if you choose to use a Startup password for the BIOS 
- 11).

• Keep copies of vital settings files such as network, dialup setting
brief notes).

Warranty

The CPU is not a user serviceable part. Opening this compartment, or access
your warranty.
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 file which tells your program 
discovered daily, and some of 
ata. Anti-Virus programs are 
lly downloadable directly from 

iruses are often triggered from 
hed file. You can configure most 
u should also beware of files 
s book and been automatically 

 provides basic information 
r to your OS’s documentation for 
 will also provide such a disk (or 
- 4 Viruses

Viruses
• Install an Anti-Virus program and keep the definitions file (the

which viruses to look for) up to date. New computer viruses are 
them may seriously harm your computer and cause you to lose d
commercially available and the definitions file updates are usua
the internet.

• Be careful when opening e-mail from sources you don’t know. V
within e-mail attachments so take care when opening any attac
Anti-Virus programs to check all e-mail attachments. Note: Yo
from people you know as the virus may have infected an addres
forwarded without the person’s knowledge.

• Keep a “Boot Floppy Disk” or “Bootable CD-ROM” (this disk
which allows you to startup your computer) handy. You may refe
instructions on how to make one, and many Anti-Virus programs
at least instructions on how to make one).
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8

oftware
unless you are very sure of what 
ystem.

ork if you are not comfortable 

 this that you are looking at the 
ou have just purchased? Many 
oftware. Always refer to the doc-
ular attention to files entitled 

ered on, and in many cases you 
s are correctly connected.

you have installed (latest driver 
Upgrading and Adding N

Upgrading and Adding New Hardware/S
• Do not be tempted to make changes to your Windows Registry 

you are doing, otherwise you will risk severely damaging your s

• Don’t open your computer or undertake any repair or upgrade w
with what you are doing.

• Read the documentation. We can assume, since you are reading
computer’s manual, but what about any new peripheral devices y
problems are caused by the installation of new hardware and/or s
umentation of any new hardware and/or software, and pay partic
“READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is pow
will need to restart the computer. Always check that all the cable

• Make sure you have installed the drivers for any new hardware 
files are usually available to download from vendor’s websites).
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 as these changes may affect one 
o back and undo the change you 

n the easier the source of the 
evices plugged into its ports, and 
ine the cause of a problem. Try 
 all the peripheral devices 
ces and restarting where neces-
be time consuming.
- 6 Upgrading and Adding New Hardware/Software

• Thoroughly check any recent changes you made to your system
or more system components, or software programs. If possible, g
just made and see if the problem still occurs.

• Don’t over complicate things. The less you have to deal with the
problem may be found; Example - if your computer has many d
a number of programs running, then it will be difficult to determ
disconnecting all of the devices and restarting the computer with
unplugged. A process of elimination (adding and removing devi
sary) will often find the source of a problem, although this may 
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8

olution

ttery bay, make sure the battery is 
ry only allows it to go in one way). 

ry contacts.

mputer doesn’t start up immediately, 

s a Power Options scheme (see 
gs. You may also be using a PC Card 

r light is broken.

ing recharged. Make sure the battery 
e reusing (see “Battery Information” 

rol Panel in Windows and re-enable 

f power. Turn off the unused device to 
Power

Problem Possible Cause - S

You turned on the power 
but it doesn’t work.

Battery missing / incorrectly installed. Check the ba
present and seated properly (the design of the batte
Make sure there’s nothing interfering with the batte

The Battery LED power 
indicator , is blinking 
orange.

Low Battery. Plug in the AC power source. If the co
turn it off then on again.

You are losing battery 
power too quickly.

The system is using too much power. If your OS ha
“Power Schemes” on page 3 - 15) check its settin
device that is drawing a lot of power.

The battery pack will not 
charge and the charge 
indicator light is off.

The battery is already fully charged and the indicato

Actual battery operating 
time is shorter than 
expected.

The battery has not been fully discharged before be
is fully discharged and recharge it completely befor
on page 3 - 20).

Power Options have been disabled. Go to the Cont
the options.

A peripheral device or PC Card is consuming a lot o
save power.
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 vent/fan intake is not blocked. If this 
 mode or turn it off for an hour. Make 
t sitting on a thermal surface (see 
using the correct adapter. 

ed off before putting it into a travel bag
 powered on in a travel bag may cause

olution
- 8 Power

The notebook feels too 
hot.

Make sure the notebook is properly ventilated and a
doesn’t cool it down, put the system into Hibernate
sure the vents aren’t blocked and the computer isn’
“Overheating” on page 1 - 18). Make sure you’re 

Make sure that your notebook is completely power
(or any such container). Putting a notebook which is
the vents/fan intakes to be blocked.

Problem Possible Cause - S
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olution

leep/resume key combination, Fn + 
on page 2 - 16).

 screen control key combinations Fn + 
 you’re connected to an external 
u should also check the monitor’s own 

e screen display key combination, Fn 
rd)” on page 3 - 8). If an external 

uch the TouchPad.

display options. Press the Fn + F6 key 

d it appropriately from the Control 
tructions on installing the driver, and 
ge 3 - 3 for instructions on configuring 
Display

Problem Possible Cause - S

Nothing appears on 
screen.

The system is in a power saving mode. Toggle the s
Esc (see “Function Keys and Numeric Keypad” 
\

The screen controls need to be adjusted. Toggle the
F9/F10 (see “Opening the LCD” on page 3 - 2). If
monitor, make sure it’s plugged in and turned on. Yo
brightness and contrast controls.

The computer is set for a different display. Toggle th
+ F6 (see “Switching/Enabling Displays (Keyboa
monitor is connected, turn it on.

The screen saver is activated. Press any key or to

No image appears on the 
external monitor I have 
plugged in and powered 
on.

You haven’t used the key combination to switch the 
combination to toggle through the options.

You haven’t installed the video driver and configure
Panel. See “What to Install” on page 4 - 1 for ins
see “Making Adjustments for the Display” on pa
the video driver.
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olution

rge the battery of the CMOS. Contact 

es of this could be serious. If you cannot
e information on your hard disk.
- 10 Boot Password

Boot Password

Problem Possible Cause - S

You forget the boot 
password.

If you forget the password, you may have to discha
your service representative for help.

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequenc
remember your boot password you must contact your vendor and you may lose all of th
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olution

 control in the Volume Control Panel 
 Fn + F11 and F12 (see “Function 
just.

ould be plugged into the headphone-
16).

ntrol panel is set too low. Click the 
for configuration options. Select the 
 that all the sliders are set to the top 
dows.

leaner kit.

Gently try to remove the disc using the 

 See “DVD Regional Codes” on 
Audio & CD Device

Problem Possible Cause - S

The sound cannot be 
heard or the volume is 
very low.

The volume might be set too low. Check the volume
in the Windows taskbar, or use the key combination
Keys and Numeric Keypad” on page 2 - 16) to ad

The headphone is plugged into the wrong jack. It sh
out jack (see “Headphone-Out Jack” on page 1 - 

The sound cannot be 
heard or the volume is 
very low when playing a 
Video CD.

The Equalizer settings in the Audio Configuration co
AC97 Audio Configuration icon  in the taskbar 
Equalizer tab, and click the ON tickbox. Make sure
level (+12dB), then click OK and close the open win

The compact disc cannot 
be read.

The compact disc is dirty. Clean it with a CD-ROM c

The compact disc tray 
will not open when there 
is a disc in the tray.

The compact disc is not correctly placed in the tray. 
eject hole (see “Loading Discs” on page 2 - 10).

The DVD regional codes 
can no longer be 
changed.

The code has been changed the maximum 5 times.
page 2 - 12.



Troubleshooting

8

8

olution

 functions. Make sure you read the 
device, and make sure you install the 
 functions which come with your 

e any standard USB keyboard. The
 keys unique to the system’s regular
- 12 Keyboard and Mouse

Keyboard and Mouse

Problem Possible Cause - S

Unwelcome numbers 
appear when typing.

If the LED  is lit, then Num Lock is turned ON. 

I have installed a new 
external keyboard or 
mouse but cannot use all 
of the listed functions.

You have not installed the driver to enable any extra
documentation which comes with any new external 
driver for it as this will allow you to access any extra
device.

Other Keyboards
If your keyboard is damaged or you just want to make a change, you can us
system will detect and enable it automatically. However special functions/hot
keyboard may not work.
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8

olution

t. Use the AC adapter, press the sleep 
tton if no LEDs are lit.

lt your OS manual. As a last resort, 
he system or if that doesn’t work, turn 

e Windows Power Options menu and
ve enabled Hibernate mode from the
Operation
Problem Possible Cause - S

The system freezes or 
the screen goes dark.

The system’s power saving features have timed-ou
(Fn + Esc) key combination, or press the power bu

A software conflict made the system “crash”. Consu
since you will lose any unsaved data, try to reboot t
the computer off and on again.

The system does not go 
into a power saving 
mode when the battery is 
low.

Power Options features are not enabled. Go to th
enable the features you prefer. Make sure you ha
control panel (see “Hibernate” on page 3 - 18).
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olution

 to see if the module(s) is(are) on or off 
e LED indicator is off, then press the 
(s). (See “Mini-PCI Wireless LAN 
age 7 - 6 and/or “PC Camera” on 

nstalled. Make sure you have installed 
ini-PCI Wireless LAN Module” on 
d/or “PC Camera” on page 7 - 11.)
- 14 Modules

Modules
Problem Possible Cause - S

The Wireless LAN/
Bluetooth/PC Camera 
modules cannot be 
detected.

The module(s) are off. Check the LED indicator 
(see “LED Status Indicators” on page 2 - 5). If th
Module On/Off button in order to enable the module
Module” on page 7 - 2,  “Bluetooth Module” on p
page 7 - 11.)

The Wireless LAN/
Bluetooth/PC Camera 
modules cannot be 
configured.

The driver(s) for the module(s) has(have) not been i
the driver(s) for the appropriate module(s). (See “M
page 7 - 2,  “Bluetooth Module” on page 7 - 6 an
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s. Certain items (particularly proces-
se schedule. Check with your service
Appendix A: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to pres
sor types/speeds) may be changed or updated due to the manufacturer's relea
center for details.
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cations

 0.13 Micron Process Technology, 1MB 
2 Cache & 400MHz FSB - 1.3/ 1.4/ 
 1.7 GHz

 0.09 Micron Process Technology, 2MB 
2 Cache & 400MHz FSB - 715/ 725/ 
A ~ 1.7 GHz)

 0.09 Micron Process Technology, 2MB 
2 Cache & 533MHz FSB - 740/ 750/ 
/ 780 (1.73 ~ 2.26 GHz)

 0.13 Micron Process Technology, 
n-die L2 Cache & 400MHz FSB - 
/ 340 (1.3 ~ 1.5 GHz)

 0.09 Micron Process Technology, 1MB 
2 Cache & 400MHz FSB - 350/ 360/ 
 ~ 1.5 GHz)

ssword
 - 2

Model A and B Specifications 

Feature Model A and B  Specifi

Processor Types Intel Pentium® M - (478-pin) Micro-FCPGA 
package

(µ0.13)
On-die L
1.5/ 1.6/

Intel Pentium® M - (478-pin) Micro-FCPGA 
package

(µ0.09)
On-die L
735 (1.5

Intel Pentium® M - (478-pin) Micro-FCPGA 
package

(µ0.09)
On-die L
760/ 770

Intel Celeron® M - (478-pin) Micro-FCPGA 
package

(µ0.13)
512KB O
320/ 330

Intel Celeron® M - (478-pin) Micro-FCPGA 
package

(µ0.09)
On-die L
370 (1.3

Core Logic SiS M661MX + SiS 963L Chipset

Structure PC2001 Compliant

Security Security (Kensington® Type) Lock Slot BIOS Pa
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A

 expandable up to 2GB (128/ 256/ 
B MB DDR modules)

 BIOS, Plug and Play (1.0a)

 15.4" WXGA TFT(1280*800) 

ic Video Memory Allocation
200

ptional” on page  A - 6)

A-133

Microphone
n Speakers

TouchPad with Scrolling Function

cations
Memory One 64-bit wide DDR channel
Two 200-pin SODIMM sockets, supporting 
266/ 333 MHz DDR modules

Memory
512/ 1G

BIOS One 4MB Flash ROM Phoenix

LCD Model A 14.1" XGA Flat Panel TFT 
(1024*768)

Model B

Display SiS M661MX Integration
Shared Memory Architecture, up to 64 MB of Dynam
Supporting Analog Monitor Resolution up to 1600 x 1
Integrated High Quality 256 bit 3D Graphics Engine
Supports 2 Displays Dual View

Storage One changeable 12.7mm(h) Optical Device Drive(see “O

Easy changeable 2.5" 9.5 mm (h) HDD
Supports Master Mode IDE
Supports PIO Mode 4/ ATA-33/ ATA-66/ ATA-100/ AT

Audio AC’97 2.2 Compliant
3D Stereo enhanced Sound system
Compatible Sound-Blaster PRO™

Built-In 
2*Built-I

Keyboard & 
Pointing Device

Winkey Keyboard Built-In 

Feature Model A and B  Specifi



A

A

s

DIF-Out Jack
-11 Jack for Plug & Play Fax/Modem
-45 Jack for 100M (Max) Fast Ethernet
-in Jack

s Battery Low Sleep Mode
s Resume From Modem Ring
s Wake on LAN

cations
 - 4

PCMCIA One Type-II PCMCIA 3.3V/5V Socket Supporting Card Bu

Interface Two USB 2.0 Ports
One External Monitor Port
One Headphone-Out Jack
One Microphone-In Jack

One S/P
One RJ
One RJ
One DC

Communication 56K Plug & Play Fax/Modem V.90/92 Compliant
10M/100M (Max) Fast Ethernet
PC Camera with USB Interface
802.11g Wireless LAN Module with Mini-PCI Interface
Bluetooth 1.1 & MDC Modem Combo Module (optional)

Power 
Management

Supports ACPI 2.0
Power Button as Sleep/Resume Key
Supports Hibernate Mode
Supports Standby Mode

Support
Support
Support

Feature Model A and B  Specifi
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A

ge AC Adapter
-Input 100~240V, 47~63Hz
 Output 20V, 3.25A (65W)

ell, Smart Lithium-Ion Battery Pack 
H (standard)

cell, Smart Lithium-Ion Battery Pack 
H (optional)

 Humidity
erating: 20% ~ 80%
n-Operating: 10% ~ 90%

 360mm (w) * 273mm (d) * 27.5mm 

ithout Battery

cations
Power Model A
Full Range AC Adapter

AC-Input 100~240V, 47~63Hz
DC Output 20V, 3.25A (65W)

One 4 cell, Smart Lithium-Ion Battery Pack 
2200mAH (standard)

One 6 cell, Smart Lithium-Ion Battery Pack 
4400mAH (optional)

Model B
Full Ran

AC
DC

One 6 c
4400mA

One 12 
8800mA

Environmental 
Spec

Temperature
Operating:  5°C ~ 35°C
Non-Operating: -20°C ~ 60°C

Relative
Op
No

Physical 
Dimensions & 
Weight

Model A 312mm (w) * 263mm (d) * 27.5mm 
(h) Min
2.2 kg without Battery

Model B
(h)  Min
2.5 kg w

Feature Model A and B  Specifi



A

A

B)
, 8800mAH, Smart Lithium-Ion Battery

5/12.7mm Height Hard Disk Drive

M Drive Module
-RW Combo Drive Module
D Drive Module

e DVD Player

era with USB Interface

 Mini-PCI WLAN Module

th & MDC Modem Combo Module

cations
 - 6

Optional (Model A)
6 Cells, 4400mAH, Smart Lithium-Ion Battery

2.5" 12.5/12.7mm Height Hard Disk Drive

DVD-ROM Drive Module
DVD/CD-RW Combo Drive Module
Dual DVD Drive Module

Software DVD Player

PC Camera with USB Interface

802.11g Mini-PCI WLAN Module

Bluetooth & MDC Modem Combo Module

(Model 
12 Cells

2.5" 12.

DVD-RO
DVD/CD
Dual DV

Softwar

PC Cam

802.11g

Bluetoo

Feature Model A and B  Specifi
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